Contents

Preface vii

1. SunVTS Overview 1-1
   1.1 What Is SunVTS? 1-1
   1.2 SunVTS Features 1-2
   1.3 SunVTS Architecture 1-4

2. Installing and Removing SunVTS 2-1
   2.1 SunVTS Packages 2-2
   2.2 Installation Requirements 2-3
   2.3 Installing SunVTS 2-3
      ▼ To Install SunVTS With the pkgadd Command 2-3
      ▼ To Set Up Access to the SunVTS Man Pages 2-6
      ▼ To Perform Additional Setup When SunVTS Is Installed in a Directory
          Other Than /opt 2-7
   2.4 SunVTS Security 2-8
   2.5 SunVTS Environmental Variables 2-13
   2.6 Additional Instructions for Localized Environments 2-14
      ▼ To Run SunVTS in English, in a Non-English Environment 2-14
      ▼ To Set Up the GUI resource File for Localized Environments 2-14
   2.7 Adding a Custom Test 2-15
To Add a Custom Test 2-15
2.8 Removing SunVTS  2-17
   ▼ To Remove SunVTS With the pkgrm Command  2-17

3. Starting SunVTS  3-1
3.1 SunVTS Runtime Considerations  3-1
3.2 Requirements for Starting SunVTS  3-2
3.3 Overview of SunVTS Procedures  3-3
3.4 Preparing Devices for Testing  3-4
3.5 Starting SunVTS on a Local System  3-5
3.6 Starting SunVTS on a Remote System  3-10
3.7 Quitting SunVTS  3-13
   ▼ To Quit SunVTS  3-13
3.8 Displaying Devices With the vtsprobe Utility  3-14
   ▼ To Display the Devices for a Local System  3-14
   ▼ To Display Devices of a Remote System  3-15

4. Using the SunVTS CDE User Interface  4-1
4.1 Getting Started with the SunVTS CDE UI  4-2
4.2 Using Additional Features with the SunVTS CDE UI  4-18
4.3 Scheduling Test Sequences With the Deterministic Scheduler  4-30

5. Using the SunVTS OPEN LOOK User Interface  5-1
5.1 Getting Started with the SunVTS OPEN LOOK UI  5-2
5.2 Using Additional Features with the SunVTS OPEN LOOK UI  5-12

6. Using the SunVTS TTY User Interface  6-1
6.1 Getting Started with the SunVTS TTY UI  6-1
6.2 Using Additional Features with the SunVTS TTY UI  6-16
A. SunVTS Window and Dialog Box Reference  A-1

B. Frequently Asked Questions  B-1
Preface

SunVTS™ is the Sun™ Validation Test Suite. SunVTS is a comprehensive diagnostic tool that tests and validates Sun hardware by verifying the connectivity and functionality of most hardware controllers, devices, on Sun platforms.

The primary audience of this manual is hardware testing and verification personnel, qualified service-trained maintenance providers, and advanced system end users.

This book describes how to install, configure, and use SunVTS.

How This Book Is Organized

Chapter 1 provides an overview of SunVTS and the SunVTS user interfaces, architecture, and test modes.

Chapter 2 describes the SunVTS packages and installation procedures.

Chapter 3 covers the different methods used to start SunVTS.

Chapter 4 describes how to configure, start, monitor, and review a test session with the SunVTS CDE UI.

Chapter 5 describes how to configure, start, monitor, and review a test session with the SunVTS OPEN LOOK UI.

Chapter 6 describes how to configure, start, monitor, and review a test session with the SunVTS TTY UI.

Appendix A provides window and dialog box look-up tables.

Appendix B provides answers to SunVTS frequently asked questions.
Using UNIX Commands

This document does not contain information on basic UNIX® commands and procedures such as shutting down the system, booting the system, and configuring devices.

See one or more of the following for this information:

- *Solaris Handbook for Sun Peripherals*
- AnswerBook2™ online documentation for the Solaris™ software environment
- Other software documentation that you received with your system
Typographic Conventions

TABLE P-1  Typographic Conventions

<table>
<thead>
<tr>
<th>Typeface or Symbol</th>
<th>Meaning</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>AaBbCc123</td>
<td>The names of commands, files, and directories; on-screen computer output.</td>
<td>Edit your .login file. Use <code>ls -a</code> to list all files. % You have mail.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>What you type, when contrasted with on-screen computer output.</td>
<td>% <code>su</code> Password:</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>Book titles, new words or terms, words to be emphasized</td>
<td>Read Chapter 6 in the <em>User’s Guide</em>. These are called <em>class</em> options. You <em>must</em> be superuser to do this.</td>
</tr>
<tr>
<td></td>
<td>Command-line variable; replace with a real name or value</td>
<td>To delete a file, type <code>rm filename</code></td>
</tr>
</tbody>
</table>

Shell Prompts

TABLE P-2  Shell Prompts

<table>
<thead>
<tr>
<th>Shell</th>
<th>Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>C shell</td>
<td><em>machine_name</em>%</td>
</tr>
<tr>
<td>C shell superuser</td>
<td><em>machine_name</em>#</td>
</tr>
<tr>
<td>Bourne shell and Korn shell</td>
<td>$</td>
</tr>
<tr>
<td>Bourne shell and Korn shell superuser</td>
<td>#</td>
</tr>
</tbody>
</table>
Related Documentation

**TABLE P-3  SunVTS Documents**

<table>
<thead>
<tr>
<th>Application</th>
<th>Document Title</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td><em>SunVTS 4.4 Test Reference</em></td>
<td>816-0796-10</td>
</tr>
<tr>
<td>Quick Reference</td>
<td><em>SunVTS Quick Reference Card</em></td>
<td>816-0861-10</td>
</tr>
</tbody>
</table>

Ordering Sun Documentation

Fatbrain.com, an Internet professional bookstore, stocks select product documentation from Sun Microsystems, Inc.

For a list of documents and how to order them, visit the Sun Documentation Center on Fatbrain.com at:

http://www.fatbrain.com/documentation/sun

Accessing Sun Documentation Online

The docs.sun.com web site enables you to access Sun technical documentation on the Web. You can browse the docs.sun.com archive or search for a specific book title or subject at:

http://docs.sun.com
Sun Welcomes Your Comments

We are interested in improving our documentation and welcome your comments and suggestions. You can email your comments to us at:

docfeedback@sun.com

Please include the part number (816-0795-10) of your document in the subject line of your email.
SunVTS Overview

This chapter covers:
- “What Is SunVTS?” on page 1-1
- “SunVTS Features” on page 1-2
- “SunVTS Architecture” on page 1-4

1.1 What Is SunVTS?

SunVTS™ is the Sun™ Validation Test Suite. SunVTS is a comprehensive diagnostic tool that tests and validates Sun hardware by verifying the connectivity and functionality of most hardware controllers and devices on Sun platforms.

Note – SunVTS is only supported on the Sun SPARC platforms.

SunVTS can be tailored to run on various types of machines ranging from desktops to servers with modifiable test instances and processor affinity features.

SunVTS supports testing in both 32-bit and 64-bit Solaris™ operating environments, automatically determines the operating environment (32-bit or 64-bit), and initiates the appropriate tests.

Use SunVTS to validate a system during development, production, receiving inspection, troubleshooting, periodic maintenance, and system or subsystem stressing.

SunVTS has a sophisticated graphical user interface (UI) that provides test configuration and status monitoring. The user interface can run on one system to display the SunVTS testing of another system on the network. SunVTS also provides a TTY-mode interface for situations in which running a graphical UI is not possible.
1.2 SunVTS Features

1.2.1 Test Categories

SunVTS comprises many individual tests for testing a wide range of Sun products and peripherals.

Use SunVTS to test one device or multiple devices. Some of the test categories are:

- Audio tests
- Communication (Serial and Parallel) tests
- Graphic/Video tests
- Memory tests
- Network tests
- Peripherals (Disks, Tape, CD-ROM, Printer, Floppy) tests
- Processor tests
- Storage tests

You need to select the proper test modes and options to maximize the effectiveness of SunVTS. This book covers the overall test configuration modes and options of the application. For information regarding the configuration of individual tests, refer to the *SunVTS 4.4 Test Reference Manual*.

1.2.2 SunVTS User Interfaces

You can run SunVTS from the following user interfaces:

- Graphical user interfaces—choose either CDE or OPEN LOOK environments. FIGURE 1-1 shows the SunVTS CDE interface.
- TTY interface—You can run SunVTS from a terminal, a shelltool, or a modem attached to a serial port using the TTY interface.
- Individual test execution—run individual tests from the command line.

*Note* – The SunVTS OPEN LOOK user interface does not support the latest SunVTS features and will be discontinued in a future release.
FIGURE 1-1  SunVTS CDE Main Window
1.2.3 SunVTS Test Modes

Based on how you configure SunVTS, the test session runs in one of the following test modes:

- **Connection test mode**—provides a low-stress, quick testing of the availability and connectivity of selected devices. These tests are non-intrusive, meaning they release the devices after a quick test, and they do not place a heavy load on system activity.

- **Functional test mode**—provides robust testing of your system and devices. It uses your system resources for thorough testing and it assumes that no other applications are running.

- **Auto Config test mode**—simplifies the SunVTS configuration process by automatically assigning a predetermined set of test options.

1.2.4 Security

SunVTS has two security mechanisms that you choose to implement when you install SunVTS:

- **Basic Security**—a local file is maintained that lists the valid users, groups, and hosts permitted to use SunVTS. This level of security does not provide secure network authentication and should not be used in an environment where network security is an issue.

- **SEAM Security**—uses the Kerberos-based, Sun Enterprise Authentication Mechanism (SEAM) to provide secure user authentication, data integrity and privacy, for transactions over networks. To use the SunVTS Kerberos security, you must have the SEAM software installed in your networked environment.

The SunVTS installation process prompts you to specify which security mechanism you want to use. You must use one or the other, and the SEAM security implementation is the default if you press the return key through the installation questions.

1.3 SunVTS Architecture

The SunVTS architecture is divided into three components: the SunVTS kernel, the user interface, and the collection of hardware tests. **FIGURE 1-2** is a block diagram representing the SunVTS architecture.
1.3.1 **SunVTS Kernel**

The following activities are scheduled and monitored by the kernel:

- Probing and saving the test system’s hardware configuration at start-up
- Logging messages reported from tests
There are two versions of the SunVTS kernel:
- 32-bit kernel—/opt/SUNWvts/bin/vtsk
- 64-bit kernel—/opt/SUNWvts/bin/sparcv9/vtsk

1.3.2 SunVTS User Interface

The SunVTS user interface is separate from the SunVTS kernel. The user interface communicates with the SunVTS kernel through an application programming interface (API). This gives SunVTS the ability to run the appropriate interface (CDE, OPEN LOOK, or TTY) based on the environment of the system. It also allows the user interface to run on a system other than the system under test.

1.3.3 SunVTS Hardware Tests

Many separate tests make up the collection of tests in the SunVTS application. Each test is a separate process from the SunVTS kernel.

When SunVTS is started, the SunVTS kernel automatically probes the system kernel to determine the installed hardware devices and displays the testable devices in the SunVTS UI. This provides a quick check of your hardware configuration, and only those tests applicable to your system are displayed.

During testing, the hardware tests send the test status and messages to the SunVTS kernel through interprocess communication (IPC) protocols. The kernel passes the status to the user interface and logs the messages.

The SunVTS kernel and most tests support 32-bit and 64-bit operating environments.
CHAPTER 2

Installing and Removing SunVTS

This chapter describes how to install and remove the SunVTS diagnostic program.

- “SunVTS Packages” on page 2-2
- “Installing SunVTS” on page 2-3
- “To Set Up Access to the SunVTS Man Pages” on page 2-6
- “To Perform Additional Setup When SunVTS Is Installed in a Directory Other Than /opt.” on page 2-7
- “SunVTS Security” on page 2-8
- “Additional Instructions for Localized Environments” on page 2-14
- “Removing SunVTS” on page 2-17
- “Adding a Custom Test” on page 2-15
2.1 SunVTS Packages

The SunVTS software is installed from the packages shown in TABLE 2-1.

<table>
<thead>
<tr>
<th>Package Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUNWvts</td>
<td>Contains the SunVTS kernel, user interface, and the collection of 32-bit binary tests. This is the main diagnostic package. You must install it to run SunVTS.</td>
</tr>
<tr>
<td>SUNWvtax</td>
<td>Provides SunVTS 64-bit binary tests and kernel. This package should be loaded on systems that support 64-bit execution, but it is not necessary for SunVTS 32-bit functionality. This package cannot be installed on systems that do not have the 64-bit Solaris operating system installed.</td>
</tr>
<tr>
<td>SUNWvtamn</td>
<td>Contains the SunVTS man pages. These files are installed in the /opt/SUNWvts/man directory by default, and you may need to update your MANPATH variable (described in this chapter). Installing these man pages is optional; however, they provide helpful information about SunVTS commands.</td>
</tr>
<tr>
<td>SUNWvtasol</td>
<td>Contains the SunVTS OPEN LOOK UI and OPEN LOOK-dependent tests. Prior to SunVTS 4.1, these components were part of the SUNWvts package. See note 3.</td>
</tr>
</tbody>
</table>

Note 1: The configd packages (SUNWeswsa, SUNWesycfd, SUNWesnta, and SUNWeswga) are no longer needed, and no longer supplied, for physical mapping support.

Note 2: As of SunVTS 4.3, the SunVTS online testing capability that was initiated using the vtsui.online command no longer available. The SUNWodu package that provides this online testing functionality no longer provided.

Online Diagnostic testing of Sun systems is now available through the Sun Management Center software using the Sun Hardware Diagnostic Suite add-on software. See [http://www.sun.com/sunmanagementcenter](http://www.sun.com/sunmanagementcenter) for details.

Note 3: The SunVTS OPEN LOOK user interface (UI) does not support the latest SunVTS features and will be discontinued when the OPEN LOOK environment is discontinued in the Solaris operating environment. When this occurs, the SunVTS OPEN LOOK tests (sundials and sunbuttons) will also be discontinued. For full feature support, use the SunVTS CDE or TTY UI. Refer to the Solaris “End-of-Software Support Statements” section of the Solaris operating environment release notes for the latest end of support news.

SunVTS packages are located on the Sun Computer Systems Supplement CD that ships with the Solaris release.
2.2 Installation Requirements

- The Solaris 8 7/01 operating environment must be installed (with the End-user cluster at minimum), and booted to multi-user level (run level 3).
- You must be superuser.
- There must be at least 62 Mbytes of available disk space in the partition where SunVTS will reside. The /opt directory is the default installation location.

**Note** – Refer to Appendix B “Frequently Asked Questions” for information about which revisions of SunVTS are supported on different Solaris operating environment releases.

2.3 Installing SunVTS

There are several utilities available for installing packages. This chapter describes how to use the `pkgadd` utility to load SunVTS from a local CD-ROM drive. For information on how to install packages using other installation methods, see the Solaris 8 7/01 Sun Hardware Platform Guide.

▼ **To Install SunVTS With the pkgadd Command**

1. Login to the system and become superuser:

   ```
   % su
   ```

2. Check to see if any SunVTS packages are currently installed on the system:

   ```
   # pkginfo -c sunvts
   ```

   - If the system does not display anything then no SunVTS packages are installed and you can proceed with the installation.
If you see any messages such as the following message, then SunVTS is installed and you should remove the existing SunVTS software before proceeding. See “Removing SunVTS” on page 2-17.

```
system       SUNWvts       SunVTS
```

3. Load the Software Supplement for the Solaris Operating Environment CD (the Supplement CD) into the CD-ROM drive.
Volume Manager automatically mounts the CD.

4. Install SunVTS using pkgadd as shown in one of the examples below.
   - The following command installs SunVTS in the default directory (/opt):
```
# pkgadd -d /cdrom/cdrom0/SunVTS_4.4/Product SUNWvts
```
   - The following command prompts you to enter the directory where SunVTS will reside instead of using the default (/opt) directory.
```
# pkgadd -a none -d /cdrom/cdrom0/SunVTS_4.4/Product SUNWvts
```

Note – If you install SunVTS in a directory other than the default (/opt) directory, you must set the VTS_PM_PATH variable before you use the SunVTS CDE interface. See “To Perform Additional Setup When SunVTS Is Installed in a Directory Other Than /opt” on page 2-7.

5. Answer the installation questions.
You are asked if you want to enable the Kerberos-based, Sun Enterprise Authentication Mechanism (SEAM) security which provides the highest level of SunVTS security. You should only enable this if you have the SEAM software installed and the SEAM server and clients configured in your networked environment. Refer to “SunVTS Security” on page 2-8. You can always answer no to this question, even when SEAM is configured in your environment.
If you choose to run SunVTS with SEAM security, use the following SEAM assignments:
- Principal—set to sunvts
- Complete Service Name—set to sunvts@host, where host is the fully qualified domain name of the host where the SunVTS kernel is running.
2-5

Chapter 2 Installing and Removing SunVTS

Note – You may see installation messages that inform you of other package requirements. These notifications do not prevent the successful installation or execution of SunVTS. The following steps explain how to install these other packages.

6. Install the SunVTS supporting packages that are appropriate for your configuration. (See “SunVTS Packages” on page 2-2 for more details.)

Example:

```
# pkgadd -d /cdrom/cdrom0/SunVTS_4.4/Product SUNWvtsx SUNWvtsmn SUNWvtsol
```

Note – Type `-a none` option again if you used it for the installation of `SUNWvts`.

Note – The `SUNWvtsx` package only installs on systems that have the 64-bit Solaris Operating Environment installed.

Note – The configd packages (`SUNWeswsa`, `SUNWsycfd`, `SUNWesnta`, and `SUNWeswga`) are no longer needed, and no longer supplied, for physical mapping support.

7. Verify the presence of the packages:

```
# pkginfo SUNWvts SUNWvtsx SUNWvtsmn SUNWvtsol
system       SUNWvts    SunVTS
system       SUNWvtsmn  SunVTS Man Pages
system       SUNWvtsol  SunVTS Open Look GUI, Sundials and Sunbuttons Tests
system       SUNWvtsx   64-bit SunVTS
```
To Set Up Access to the SunVTS Man Pages

The SunVTS man pages are installed in the SunVTS_install_dir/man directory (/opt/SUNWvts/man by default). To access them, add this directory to your MANPATH shell variable in the initialization file that corresponds to your login shell (usually .profile for the Bourne and Korn shells or .login for the C shell).

**Note** – The steps that follow assume that the default SunVTS installation directory (/opt) was used when the SunVTS packages were installed. If this is not the case, adjust the instructions to use the directory where the man pages were installed.

1. **Using an editor, add the SunVTS man directory (/opt/SUNWvts/man by default) to the MANPATH variable in the appropriate initialization file.**

   Bourne, Korn Shell example:

   ```
   MANPATH=/usr/share/man:/usr/man:/opt/SUNWvts/man;export MANPATH
   ```

   C shell example:

   ```
   setenv MANPATH /usr/share/man:/usr/man:/opt/SUNWvts/man
   ```

2. **Have the shell read the modified initialization file by sourcing it (with the . [dot] or source command) or log out and log back in.**

3. **Verify that the SunVTS man directory is part of the MANPATH variable:**

   ```
   # echo $MANPATH
   /usr/share/man:/usr/man:/opt/SUNWvts/man
   ```

**Note** – For more information about customizing a user’s work environment, shell variables, and initialization files, refer to your Solaris system administration guides.
To Perform Additional Setup When SunVTS Is Installed in a Directory Other Than /opt

When you install SunVTS in a directory other than the default directory (/opt), you must set the VTS_PM_PATH environment variable before you can use the SunVTS CDE user interface. This variable is used to locate graphic elements in the SunVTS CDE interface.

**Note** – The VTS_PM_PATH variable is not required if SunVTS is installed in the default directory (/opt).

1. Using an editor, open the appropriate initialization file such as .profile (for the Bourne or Korn shells) or .login (for the C shell).

2. Add the VTS_PM_PATH variable as shown:
   - Bourne or Korn Shell example:
     ```
     VTS_PM_PATH=your_base_install_dir/SUNWvts/bin/pm;export VTS_PM_PATH
     ```
   - C shell example:
     ```
     setenv VTS_PM_PATH your_base_install_dir/SUNWvts/bin/pm
     ```

3. Have the shell read the modified initialization file by sourcing it (with the . [dot] or source command) or log out and log back in.
2.4 SunVTS Security

SunVTS has two security mechanisms that you can choose from:

- **Basic Security**—a local file is maintained that lists the valid users, groups, and hosts that are permitted to use SunVTS. This level of security does not provide secure network authentication and should not be used in an environment where network security is an issue.

- **SEAM Security**—uses the Sun Enterprise Authentication Mechanism™ (SEAM) to provide secure user authentication, data integrity and privacy, for transactions over networks using a Kerberos V5 technology.

The SunVTS installation process prompts you to specify which security mechanism you want to use. You must use one or the other, and the SEAM security implementation is the default if you press the return key through the installation questions.

2.4.1 Basic Security

The SunVTS user interface (vtsui, vtsui.ol, and vtstty) must connect to the SunVTS kernel (vtsk) *before* it can be used to control testing. The SunVTS kernel selectively accepts “connect to” requests from the SunVTS interface based on entries in the `SunVTS_install_dir/bin/.sunvts_sec` file. Connection permission is governed by three categories in this file as follows:

- **HOSTS**—if the requesting user is on a host that belongs to the HOSTS category, then this request is granted without any authentication.

- **GROUPS**—if the requesting user is a member in a group that is a member of GROUPS category, then the user interface will prompt the user for a password. The SunVTS kernel compares this password against the password database on the system under test (SUT). If the password does not match, or if the user is not on the list, then the connection is rejected.

- **USERS**—if the requesting user is a member of the USER category, then the user interface will prompt the user for a password. The SunVTS kernel compares this password against the password database on the SUT. If the password does not match, or the user is not on the list, then the connection is rejected.

A plus (+) entry in one of these categories means all hosts, groups, or users, are trusted.

The user password needed for authentication is the same password used to log in to the system under test.
The check for connection permission starts with the HOSTS category, then the GROUP category, and finally, the USERS category. A connection is granted as soon as the connection request matches an entry.

If a security file entry is invalid or if there is no entry in the file, all access except root is denied on the local machine. However, you can correct an entry in this file even while the SunVTS kernel is running.

When you specify the -e option while starting the SunVTS kernel, the kernel accepts “connect to” requests from any host, regardless of the entries in the .sunvts_sec file.

**Note** – As of SunVTS 3.1, the .sunvts_sec file, by default, is configured for root on the system under test. All other “connect to” requests are rejected.

**Note** – The .sunvts_sec file is bypassed if you enable the SEAM security.

The following shows the contents of the default .sunvts_sec file.
Code Example of the Security File (*.sunvts_sec):  

```bash
#This file should be <SunVTS 4.4 install directory>/bin/.sunvts_sec
#
#Any line beginning with a # is a comment line
#
# Trusted Hosts entry
# One hostname per line.
# A "+" entry on a line indicates that ALL hosts are Trusted Hosts.
# No password authentication is done.
# The line with the label HOSTS: is required to have the list of hosts
#
HOSTS:
#+
#host1
#host2
#
# Trusted Groups entry
# One groupname per line.
# A "+" entry on a line indicates that ALL groups are Trusted Groups.
# User password authentication is done.
# The line with the label GROUPS: is required to have the list of groups
#
GROUPS:
#groupl
#
# Trusted Users entry
# One username per line.
# A "+" entry on a line indicates that ALL users are Trusted Users.
# User password authentication is done.
# The line with the label USERS: is required to have the list of users.
USERS:
root
#user1
#user2
```
2.4.2 SEAM Security

To use SEAM-based security with SunVTS, you must have the following:

- The complete SEAM 1.0.1 client/server application must be installed and running in your network environment.
- The systems for which you install SunVTS must have, at minimum, the SEAM 1.0.1 client software installed.
- Select the SEAM-based security (Kerberos V5) choice during the SunVTS installation.

**Note** – Refer to the following documents for more information on SEAM:
- *Sun Enterprise Administration Mechanism 1.0.1 Guide*
- *SEAM 1.0.1 Installation and Release Notes*

These documents are part of the Sun Enterprise Authentication Mechanism 1.0.1 AnswerBook Collection, and available at [http://docs.sun.com](http://docs.sun.com).

The SEAM software is part of the Solaris release.

The SunVTS SEAM security system is based on Kerberos V5 technology, which revolves around the concept of a *ticket*. A ticket is a set of electronic information that serves as identification for a user or a service. When you connect to another host through SunVTS, you transparently send a request for a ticket to a Key Distribution Center (KDC), which accesses a database to authenticate your identity. The KDC returns a ticket granting you permission to access the other machine.

“Transparently” means that you do not need to explicitly request a ticket; it happens in the background as part of the remote connection. No user password is transmitted in the network. Only the authenticated client can get a ticket for a specific service; another client cannot gain access under an assumed identity.

If you choose to run SunVTS with SEAM security, use the following SEAM assignments:

- **Principal**—set to *sunvts*
- **Complete Service Name**—set to *sunvts@host*, where *host* is the fully qualified domain name of the host where the SunVTS kernel is running.

2.4.3 Controlling SunVTS Security

▼ To Control SunVTS Security mode at Installation Time

The best time to establish the SunVTS security mode is during the SunVTS installation.
1. Decide which level of security you want to use with SunVTS.
   If you decide to use the SEAM security (highest level of security), make sure that your system is running SEAM.

2. Install SunVTS as described in “Installing SunVTS” on page 2-3.
   The installation program asks you if you want SEAM security enabled. Answer accordingly:
   - **Yes** (the default)—The Kerberos SEAM security is enabled for SunVTS. No additional action is required to administer SunVTS security. SunVTS uses the authentication as defined in the SEAM software configuration in your network environment to grant and deny access to SunVTS. Do NOT select this security scheme if you do not have the SEAM software installed and configured in your network environment.
   - **No**—The basic security file is used, and SEAM is not enabled. When the installation is complete, you can access SunVTS as superuser on the system under test, or modify the `.sunvts_sec` file to authorize other users.

▼ To Switch SunVTS Security After Installation

If you need to switch the security from SEAM to basic, or vice-versa, after you have installed SunVTS, follow these steps:

1. Become superuser.
2. Make sure that SunVTS is not started.
3. Change directories to the SunVTS binary directory:

   ```bash
   # cd /opt/SUNWvts/bin
   ```

   **Note** – If SunVTS is installed in a directory other than `/opt`, adjust your references accordingly.

4. With an editor, open the `.sunvts_sec_gss` file.

   This file contains one line that is appended with one of the following:
   - **ON**—indicates SEAM security is enabled.
   - **OFF**—indicates SEAM security is disabled, and basic security is used.

5. Change the **ON** (or **OFF**) value to the opposite value, save the change, and quit the editor.

   **Note** – The **ON** and **OFF** values are case sensitive. Make sure you specify them using capital letters.
6. Start SunVTS.
   The security mechanism that you specified is enabled.

### 2.5 SunVTS Environmental Variables

Use environmental variables to control certain aspects of SunVTS as described in TABLE 2-2. Except for the MANPATH variable, you only use these variables when you need to alter the default characteristics of SunVTS.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BYPASS_FS_PROBE</td>
<td>Used by disktest when you want to run subtests that require SunVTS to pre-mount all mountable partitions. Refer to the disktest chapter in the SunVTS 4.4 Test Reference Manual for details.</td>
</tr>
<tr>
<td>MANPATH</td>
<td>Append the MANPATH variable with the location of the SunVTS man page location (/opt/SUNWvts/man by default) so the man command can locate and display the SunVTS man pages. See “To Set Up Access to the SunVTS Man Pages” on page 2-6.</td>
</tr>
<tr>
<td>VTS_CMD_HOST</td>
<td>Used by the vts_cmd command to specify the hostname for the SunVTS kernel to connect to. Refer to the vts_cmd man page for details.</td>
</tr>
<tr>
<td>VTS_OLD_MSG</td>
<td>Only used when you want SunVTS to display test messages in a pre-SunVTS 4.0 format, usually because a script relies on the older format. This variable should only be used temporarily until your script is updated to recognize the new message format. This variable, and the old message format will no longer be supported in a future version of SunVTS. See question 22 in Appendix B “Frequently Asked Questions”.</td>
</tr>
<tr>
<td>VTS_PM_PATH</td>
<td>Only used when SunVTS is not installed in the default directory (/opt). Set VTS_PM_PATH to vts_install_dir/SUNWvts/bin/pm for proper operation of the SunVTS CDE UI. See “To Perform Additional Setup When SunVTS Is Installed in a Directory Other Than /opt” on page 2-7.</td>
</tr>
</tbody>
</table>
2.6 Additional Instructions for Localized Environments

SunVTS software is available in English, and is Internationalization (I18N) compliant, which means it is structured in a way that a user who is familiar with internationalization can take advantage of this feature to run SunVTS in a localized environment.

In a localized environment, you can run SunVTS in English or with localized fonts. Perform one of the two following procedures based on how you want SunVTS to run.

▼ To Run SunVTS in English, in a Non-English Environment

Set the \texttt{LANG} variable to English before you start SunVTS. The following is an example using the C shell:

1. Set the \texttt{LANG} variable:

   \begin{verbatim}
   # setenv \texttt{LANG} C
   \end{verbatim}

▼ To Set Up the GUI \texttt{resource} File for Localized Environments

1. As superuser, create a directory as follows:

   \begin{verbatim}
   # mkdir -p /opt/SUNWvts/lib/locale/\texttt{LANG}/app-defaults
   \end{verbatim}

   Where \texttt{LANG} is the language code (for example, \texttt{ja} for Japan EUC, or \texttt{fr} for French) for the language that you are using.

2. Copy the SunVTS \texttt{Xresource (Vtsui)} file into the directory you just created:

   \begin{verbatim}
   # cp /opt/SUNWvts/lib/Vtsui /opt/SUNWvts/lib/locale/\texttt{LANG}/app-defaults
   \end{verbatim}
2.7 Adding a Custom Test

Developers can add their own custom tests to the SunVTS environment. This book does not describe custom test development, but does list the tasks necessary to add a custom test into the SunVTS environment.

▼ To Add a Custom Test

1. Copy your custom test binary to the SunVTS bin directory based on the 32-bit or 64-bit functionality of your binary test:
   ■ 32-bit: /opt/SUNWvts/bin
   ■ 64-bit: /opt/SUNWvts/bin/sparcv9

2. Modify one of the following .customtest files based on the 32-bit or 64-bit functionality of your binary test:
   ■ 32-bit: /opt/SUNWvts/bin/.customtest
   ■ 64-bit: /opt/SUNWvts/bin/sparcv9/.customtest
   The format of the .customtest file is described in “The .customtest File Format” on page 2-15.

3. Restart SunVTS or reprobe the system.
   When invoked, SunVTS displays the custom test in the SunVTS user interface.

2.7.1 The .customtest File Format

The .customtest file defines the test options and the default option values for your custom test. The tester can change these options using the option dialog boxes through the SunVTS user interface. However, the Reset button returns the options to the default settings as defined in the .customtest file.
Each line in this file is made up of two or more fields that are separated by a semicolon where:
- The first field is the label or device name (mandatory field).
- The second field is the test name (mandatory field).
- The third field is an option line (optional field). If used, this field must be in the format specified.
- The fourth field is used if the test is scalable. If used, append the keyword SCA to this field.

Examples:
- To add a test with no options:

  
  % your_label_name; your_test_name

- To add the scalability option, append the keyword SCA:

  
  % your_label_name; your_test_name; SCA

- To custom build an option menu, add an option specification:

  
  % Option_Name<Option_Type | Value | Default_Value | Command_Line_Option>

- To specify more than one option, separate each option by a comma:

  
  % label_name; test_name; Numeric<NUMERIC | 0,100 | 50 | numeric>,
  Exc_Choice<EXC_CHOICE | Top, Middle, Bottom | Middle | exc_choice>,
  Inc_Choice <INC_CHOICE | Left, Center, Right | Left + Center + Right | inc_choice>,
  Toggle<TOGGLE | This, That | This | toggle>,
  Text<TEXT | 20 | Type_Here | text>, Slidebar<SLIDEBAR | 0,10 | 5 | slidebar>,
  Errors<CYCLE | Yes, No | No | errors>,
  Cycle<CYCLE | First, Second, Third | First | cycle>; SCA

SunVTS invokes the above test as follows:

  
  % .test_name -s[vq..] [-i n]
  -o dev=user[0,1..], Command_Line_Option=Value...
You cannot use the .customtest file when a test has a probe attached. You must ensure that the binaries are compatible with the version of the Solaris kernel on which SunVTS is currently running.

**Note** – If .customtest is renamed as .customtest-group, all of the associated tests will appear under the specified group.

### 2.8 Removing SunVTS

It is necessary to remove SunVTS before installing a new version. The following instructions describe how to remove SunVTS using the `pkgrm` command.

▼ **To Remove SunVTS With the `pkgrm` Command**

1. Log in to the system and become superuser.

   ```
   % su
   ```

2. Remove the packages with the `pkgrm` command:

   ```
   # pkgrm SUNWvtsx SUNWvtsmn SUNWvtsol SUNWodu SUNWvts
   (see note below)
   ```

**Note** – As of SunVTS 4.3, the SUNWodu package is an obsolete SunVTS package that will only be present if you have an older version of SunVTS installed. If you have this package installed, you should remove it before reinstalling any version of SunVTS.

Answer `y` (yes) to the removal questions.

You should see Removal of *package_name* was successful.
3.1 SunVTS Runtime Considerations

Before you start SunVTS, consider the following runtime issues:

- **System load**—Before you run SunVTS on your system you should consider the added system activity created by SunVTS and consider its effect on users. Depending on the mode that you select, testing can add significantly to your system load or be quite minimal. Added load is desirable when using SunVTS for system stress testing and validation.

- **Other applications**—Some SunVTS tests stress the system resources (such as virtual memory) to the point that other applications might not run.

- **System functionality**—SunVTS is a diagnostic tool. It only runs when your system is fully booted to run level 3 (multi-user level). SunVTS will not run from single-user (maintenance mode) nor from run level 0 (monitor mode).
Superuser access—For security reasons, only superuser is permitted to run SunVTS unless the SunVTS security file is modified when you use the basic SunVTS security scheme.

Graphics Tests—Running tests on frame buffers has two key considerations: You must not run any other application or screen saver program that uses the frame buffer. The frame buffer graphic tests print test patterns on the display. This temporarily prevents you from working in your window environment.

Swap Space—The amount of swap space required for testing varies widely with individual hardware and software configurations. If an adequate amount of swap space is not available on your machine, a window pops up and displays the amount of additional swap space needed.

Latest SunVTS news—Refer to the /opt/SUNWvts/README file for the latest SunVTS updates.

3.2 Requirements for Starting SunVTS

Your system must meet the following requirements to run SunVTS:

- The SunVTS packages must be installed on the systems on which you plan to run SunVTS. Refer to “Installing and Removing SunVTS” on page 2-1 for installation information.
- The system must be booted to the multiuser level.
- To run SunVTS with a graphical user interface (GUI), that GUI must be installed (either CDE or OPEN LOOK). Otherwise, start SunVTS with the TTY interface.

Note – Although it is not a requirement, it is good practice to prepare devices like tape drives, CD-ROM drives, and diskette drives by installing the proper media before starting SunVTS. This practice assures the most reliable device-probe results. See “Preparing Devices for Testing” on page 3-4 for more information.
3.3 Overview of SunVTS Procedures

The following table describes the process for testing your system with SunVTS. The table provides a brief description, and refers you to the location in the document for more detailed information.

<table>
<thead>
<tr>
<th>TABLE 3-1</th>
<th>SunVTS Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step</strong></td>
<td><strong>Procedure</strong></td>
</tr>
<tr>
<td>1</td>
<td>Become superuser</td>
</tr>
<tr>
<td>2</td>
<td>Determine the current state of the system you plan to test</td>
</tr>
<tr>
<td>3</td>
<td>Prepare devices for testing</td>
</tr>
<tr>
<td>4</td>
<td>Start your desired graphical environment (optional)</td>
</tr>
</tbody>
</table>
| 5          | Start SunVTS       | There are many ways to start the SunVTS application. Refer to the following sections:  
• “Starting SunVTS on a Local System” on page 3-5  
• “Starting SunVTS on a Remote System” on page 3-10  
• “Displaying Devices With the vtsprobe Utility” on page 3-14 |
| 6          | Set up SunVTS with your desired test session configuration | The method for doing this depends on the SunVTS interface that you are using:  
• Chapter 4 “Using the SunVTS CDE User Interface”  
• Chapter 5 “Using the SunVTS OPEN LOOK User Interface”  
• Chapter 6 “Using the SunVTS TTY User Interface” |
3.4 Preparing Devices for Testing

Several tests require the installation of media or loopback connectors. Install such requirements before the SunVTS kernel probes for devices (when SunVTS is started, or when the SunVTS reprobe command is run) to allow the SunVTS kernel to properly identify each device.

You must install media in these devices if you plan to test them in Functional Mode:

- **Tape drive**—Load a *scratch* tape in the tape drive that you plan to test. The tape test has a Read-only mode, but use a scratch tape to avoid inadvertently writing over data.
- **CD-ROM and DVD drives**—Load appropriate media into the drive. It can be an audio or data CD.
- **Diskette drive**—Load a *scratch* diskette in the drive. The diskette test has a Read-only mode, but use a scratch tape to avoid inadvertently writing over data.
- **SmartCard Reader**—Allocate a *scratch* smart card for testing purposes because the SmartCard test writes on the card.
- **Communication ports**—Many of these tests require a loopback connector attached to the port. Attach any required loopback connectors for the ports you plan to test. For more information about loopback connectors refer to the *SunVTS 4.4 Test Reference Manual*.
- **Printer ports**—Requires connection to a printer.

**Note** – Any device that requires your intervention before the test can run (such as loading media for tape, CD-ROM, and diskette tests), also requires that you notify SunVTS that you have performed this action by selecting the Intervention checkbox. You cannot select any intervention mode tests until you select this checkbox.

---

### TABLE 3-1 SunVTS Procedures (Continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Run the tests</td>
<td>To run the tests, select the <em>start</em> button in the SunVTS interface. The testing process may take as little as one second, or run indefinitely, based on how SunVTS is configured.</td>
</tr>
<tr>
<td>8</td>
<td>Review the test results</td>
<td>Test results are displayed real-time in the SunVTS interface and logged in three log files. You can also configure SunVTS to notify you by email.</td>
</tr>
<tr>
<td>9</td>
<td>Quit SunVTS</td>
<td>Refer to “Quitting SunVTS” on page 3-13 for more details.</td>
</tr>
</tbody>
</table>
3.5 Starting SunVTS on a Local System

This section describes the common ways to start SunVTS:

- "Using the sunvts Command" on page 3-5
- "Starting the SunVTS Kernel and Interface Separately" on page 3-7
- "Starting SunVTS to Test an Online System" on page 3-9

3.5.1 Using the sunvts Command

The typical way to start SunVTS is to use the `sunvts` command. This command starts the SunVTS kernel, either the 32-bit or 64-bit version, and one of the SunVTS user interfaces, based on your system environment.

The SunVTS UI that starts is determined by the following criteria:

- When the CDE window manager (`DTWM`) is running, the SunVTS CDE UI is started (`vtsui`).
- When the OPEN LOOK window manager (`OLWM`) is running, the SunVTS OPEN LOOK UI is started (`vtsui.ol`).
- If no window manager is running, then the SunVTS TTY UI is started (`vtstty`).

Note – The `sunvts` command starts SunVTS assuming that the system under test is in an offline state. All other system applications should be stopped.

▼ To Start SunVTS with the `sunvts` command

1. Become superuser.
2. Run the `sunvts` command:

   ```bash
   # /opt/SUNWvts/bin/sunvts
   ```

Note – If you receive an error message such as:
connection to ":0.0" refused by server
Xlib: Client is not authorized to connect to Server
Error: Can’t open display: :0.0
You may need to grant xhost permissions by typing: `xhost display_hostname`
3. Refer to one of the following chapters according to the SunVTS UI you are using:
   ■ “Using the SunVTS CDE User Interface” on page 4-1
   ■ “Using the SunVTS OPEN LOOK User Interface” on page 5-1
   ■ “Using the SunVTS TTY User Interface” on page 6-1

▼ To Use the sunvts Command With Options

You can use the sunvts command with a variety of options (TABLE 3-2) to control how SunVTS is started.

1. For example, the following command starts SunVTS with the TTY UI no matter what window environment you are using:

   ```
   # /opt/SUNWvts/bin/sunvts -t
   ```

**TABLE 3-2  The sunvts Command Syntax**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-e</code></td>
<td>Disables the connection permission checking feature</td>
</tr>
<tr>
<td><code>-l</code></td>
<td>Starts the SunVTS OPEN LOOK user interface. The SUNWvtsol package must be installed to use the OPEN LOOK user interface</td>
</tr>
<tr>
<td><code>-p</code></td>
<td>Starts the SunVTS kernel, but does not probe the test system’s devices</td>
</tr>
<tr>
<td><code>-q</code></td>
<td>Automatically quits both the SunVTS kernel and the user interface when testing stops</td>
</tr>
<tr>
<td><code>-s</code></td>
<td>Automatically starts testing a selected group of tests; the flag must be used with the <code>-o options_file</code> flag</td>
</tr>
<tr>
<td><code>-t</code></td>
<td>Starts vtstty, a TTY-based program. If you do not specify this option, and the system is running CDE, sunvts starts vtsui. If the system is running OPEN LOOK, sunvts starts vtsui.ol</td>
</tr>
<tr>
<td><code>-v</code></td>
<td>Displays version information from the SunVTS kernel and UI</td>
</tr>
<tr>
<td><code>-o options_file</code></td>
<td>Starts the SunVTS kernel with the test options loaded from the options file; these options are saved by the user interface and are stored in the /var/opt/SUNWvts/options directory</td>
</tr>
</tbody>
</table>
3.5.2 Starting the SunVTS Kernel and Interface Separately

The `sunvts` command starts both the SunVTS kernel and the user interface that is appropriate for your system. However, there are commands that you can use to start just the SunVTS kernel, or to specify a specific user interface.

▼ To Start the SunVTS Kernel (`vtsk`)

1. The `vtsk` command starts the SunVTS kernel. You can use command-line options (see TABLE 3-3 below) to control the behavior of this command.

   - For systems running in the 32-bit Solaris environment, use the following command:

   ```bash
   # /opt/SUNWvts/bin/vtsk
   ```

---

**TABLE 3-2 The sunvts Command Syntax (Continued)**

```
/opt/SUNWvts/bin/sunvts [-elpqstv] [-o options_file] [-f logfile_directory] [-h hostname] -display local_hostname:0
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-f logfile_directory</code></td>
<td>Specifies an alternative logfile directory other than the default directory <code>/var/opt/SUNWvts/logs</code></td>
</tr>
<tr>
<td><code>-h hostname</code></td>
<td>Starts the user interface (<code>vtsui</code> or <code>vtstty</code>) on the local machine and tries to connect to the SunVTS kernel (<code>vtsk</code>) of the specified host machine. If <code>hostname</code> is the same hostname of the machine on which the tests are being run, <code>sunvts</code> starts the SunVTS kernel (<code>vtsk</code>). If <code>vtsk</code> is already running on the test system, the <code>sunvts</code> command ignores the <code>-o</code>, <code>-f</code>, <code>-q</code>, <code>-p</code>, and <code>-s</code> options.</td>
</tr>
<tr>
<td><code>-display local_hostname:0</code></td>
<td>When running SunVTS through a remote login, this option starts the SunVTS kernel on the remote system, and the user interface is displayed on the local machine designated as <code>local_hostname:0</code></td>
</tr>
</tbody>
</table>
For systems running in the 64-bit Solaris environment, use the following command:

```bash
# /opt/SUNWvts/bin/sparcv9/vtsk
```

The `vtsk` command-line syntax and options are listed below:

**TABLE 3-3  The vtsk Syntax**

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-e</code></td>
<td>Disables the connection permission checking feature</td>
</tr>
<tr>
<td><code>-p</code></td>
<td>Starts the SunVTS kernel, but does not probe test system devices</td>
</tr>
<tr>
<td><code>-q</code></td>
<td>Quits both the SunVTS kernel and the user interface when testing is complete</td>
</tr>
<tr>
<td><code>-s</code></td>
<td>Starts testing a selected group of tests; this flag must be used with the <code>-o options_file</code> flag</td>
</tr>
<tr>
<td><code>-v</code></td>
<td>Displays only the version information from the SunVTS kernel, <code>vtsk</code>; this option does not start the <code>vtsk</code> daemon</td>
</tr>
<tr>
<td><code>-o options_file</code></td>
<td>Starts the SunVTS kernel with the test options saved in the <code>options_file</code>; these options are saved and stored in the <code>/var/opt/SUNWvts/options</code> directory</td>
</tr>
<tr>
<td><code>-f logfile_directory</code></td>
<td>Specifies an alternative to the default logfile directory (<code>/var/opt/SUNWvts/logs</code>)</td>
</tr>
</tbody>
</table>
To Start a Specific SunVTS User Interface

In most cases, when you use the `sunvts` command, the appropriate SunVTS user interface is started.

1. **For situations when you want to start a specific user interface without starting the SunVTS kernel, use one of the following:**
   - To start the CDE interface:
     ```bash
     # /opt/SUNWvts/bin/vtsui
     ```
   - To start the OPEN LOOK interface:
     ```bash
     # /opt/SUNWvts/bin/vtsui.ol
     ```
   - To start the TTY interface:
     ```bash
     # /opt/SUNWvts/bin/vtstty
     ```

In all cases, the user interface attempts to connect to the SunVTS kernel.

Starting SunVTS to Test an Online System

As of SunVTS 4.3, the SunVTS online testing capability that was initiated using the `vtsui.online` command is no longer available. The SUNWodu package that provides this online testing functionality is no longer provided.

Online Diagnostic testing of Sun systems is now available through the Sun Management Center software using the Sun Hardware Diagnostic Suite add-on software. See [http://www.sun.com/sunmanagementcenter](http://www.sun.com/sunmanagementcenter) for details.

Before you start a SunVTS test session stop all user applications.
3.6 Starting SunVTS on a Remote System

You can start, view, and control SunVTS testing sessions over a network. There are several ways to do it, but the desired effect is to have SunVTS display the SunVTS user interface on the local system (the system that you are on), while the SunVTS kernel is running and testing a remote system (connected via Ethernet, modem lines, and the like).

The following procedures are described in this section:

■ “To Connect the User Interface to a Remote System” on page 3-10
■ “To Run SunVTS Through a Remote Login” on page 3-11
■ “To Run SunVTS Through telnet or tip (TTY Interface)” on page 3-12

3.6.1 Requirements

In addition to the normal SunVTS requirements (refer to “Requirements for Starting SunVTS” on page 3-2), the following requirements must be met to run SunVTS on a remote system:

■ The user or host making the remote connection must be an authorized SunVTS user, either through the .sunvts_sec file (basic security), or through the SEAM security scheme. See “SunVTS Security” on page 2-8.
■ The same version of SunVTS must be installed on both the local and remote systems.

▼ To Connect the User Interface to a Remote System

1. Type the following command:

```
# /opt/SUNWvts/bin/sunvts -h remote_hostname
```

Replace `remote_hostname` with the hostname or IP address of the remote system.

The `sunvts` command starts the SunVTS kernel (vtsk) on the remote system, and starts the SunVTS user interface on the local system. The user interface connects to the kernel and displays the test session of the remote system. Refer to FIGURE 3-1 below.

The term `system under test (SUT)` refers to the system running the SunVTS kernel, which is the remote system in this example.
FIGURE 3-1 Running sunvts With the –h Option

Note – If the user interface is already running on your local system, you can use the “Connect to” button to connect to a remote machine SunVTS kernel, provided that the SunVTS security is set up properly.

2. Configure SunVTS for the test session and start the tests as described in the following sections:
   ■ “Using the SunVTS CDE User Interface” on page 4-1
   ■ “Using the SunVTS OPEN LOOK User Interface” on page 5-1
   ■ “Using the SunVTS TTY User Interface” on page 6-1

▼ To Run SunVTS Through a Remote Login

1. Use the xhost command to allow the remote system to display on your local system.

   % /usr/openwin/bin/xhost + remote_hostname

   Replace remote_hostname with the name of the remote system.

2. Log in to the remote system as superuser.
   Use a command such as rlogin.
3. Start SunVTS:

```
# /opt/SUNWvts/bin/sunvts -display local_hostname:0
```

Replace `local_hostname` with the name of the local system. The SunVTS kernel starts on the remote system and the user interface displays on your system.

4. Configure SunVTS for the test session and start the tests.
   - “Using the SunVTS CDE User Interface” on page 4-1
   - “Using the SunVTS OPEN LOOK User Interface” on page 5-1
   - “Using the SunVTS TTY User Interface” on page 6-1

▼ To Run SunVTS Through `telnet` or `tip` (TTY Interface)

You can run SunVTS on a remote system with the TTY interface through a `telnet` or `tip` session.

You need to set the correct terminal type and number of columns and rows before starting the interface. The steps below describe this process.

1. **Use the `echo` command to display the value of the `TERM` variable:**
   In this example, the `TERM` variable is a Korn or Bourne shell variable and the value is `sun-cmd`. Your display device may be something else like a Wyse, TeleVideo, or other kind of terminal. In that case your `TERM` value will be something different.

   ```
   $ echo $TERM
   sun-cmd
   ```

2. **Use the `stty` command to display the settings of your terminal:**

   ```
   $ stty
   speed 9600 baud; -parity hupcl
   rows = 60; columns = 80; ypixels = 780; xpixels = 568;
   swtch = <undef>;
   brkint -inpck -istrip icrnl -ixany imaxbel onlcr
   echo echoe echok echoctl echoke iexten
   ```

   **Note** — You must have a minimum of 80 columns and 24 rows to run the SunVTS TTY interface.
3. Write down the values of your `TERM` variable and `rows` and `columns` settings.
   You will need these values later.

4. Connect to the remote system using either the `telnet` or `tip` commands.
   Refer to the `telnet(1)` and `tip(1)` man pages for more information about these commands.

5. Become superuser on the remote system.

6. Identify your terminal type and settings in the telnet (or tip) session window:

   ```
   # TERM=sun-cmd
   # stty rows 60
   # stty columns 80
   ```

7. Start SunVTS with the TTY interface:

   ```
   # /opt/SUNWvts/bin/sunvts -t
   ```

8. Configure SunVTS for the test session and start the tests.
   Refer to “Using the SunVTS TTY User Interface” on page 6-1.

### 3.7 Quitting SunVTS

▼ To Quit SunVTS

1. If SunVTS is testing, stop the test session before quitting SunVTS.

2. To quit SunVTS, access the Quit SunVTS submenu and choose from one of the following:
   - `vts kernel and ui`—terminates the user interface and the SunVTS kernel
   - `vts kernel`—terminates only the SunVTS kernel
   - `vts ui`—terminates only the user interface
   - Quit Button—terminates only the user interface
3.8 Displaying Devices With the vtsprobe Utility

The vtsprobe command lists all of the system testable devices, associated configuration information, and corresponding hardware tests.

The SunVTS kernel must be running on the test machine for the vtsprobe command to work. See “Starting the SunVTS Kernel and Interface Separately” on page 3-7.

Any user or remote host that wishes to run vtsprobe must be listed in the .sunvts_sec file. By default, root on the local host is listed.

▼ To Display the Devices for a Local System

1. Type the following command:

   CODE EXAMPLE 3-1  vtsprobe Example

   ```
   example% /opt/SUNWvts/bin/vtsprobe
   
   Processor(s)
   fpu(fputest)
   Architecture: sparc
   Type: TI TMS390250 SuperSPARC chip
   system(systest)
   System Configuration: sun4m SPARCstation 10 (1 X 390250)
   System clock frequency: 40 MHz
   SBUS clock frequency: 20 MHz
   Memory
   kmem(vmem)
   Amount: 233580KB
   mem(pmem)
   Physical Memory size: 48 Mb
   Network
   isdn0(isdntest)
   le0(nettest)
   Host_Name: example
   Host Address: 131.155.56.122
   Host ID: 12347f61
   Domain Name: widget.com
   ```
To Display Devices of a Remote System

**Note** – The user or local host must be listed in the `.sunvts_sec` file on the remote system.

1. Make sure that the SunVTS kernel is running on the remote system.

2. Type the following command:

   ```
   # vtsprobe -h hostname
   ```

   The `vtsprobe` utility connects to the remote machine and displays the hardware devices of the remote machine. The output is displayed on the window in which you invoke `vtsprobe`. 
Using the SunVTS CDE User Interface

This chapter describes how to run a test session using the SunVTS CDE UI. The procedures are written in a step-by-step form so you can use them to become familiar with SunVTS using the SunVTS CDE UI. This chapter is divided into the following sections:

- “Getting Started with the SunVTS CDE UI” on page 4-2
- “Using Additional Features with the SunVTS CDE UI” on page 4-18
- “Scheduling Test Sequences With the Deterministic Scheduler” on page 4-31

**Note** – This chapter assumes that you have already performed the following procedures:

- Installed SunVTS as described in Chapter 2 “Installing and Removing SunVTS”,
- Started SunVTS as described in Chapter 3 “Starting SunVTS”,
- Prepared your system for testing as described in Section 3.4 “Preparing Devices for Testing”.

See Appendix A “SunVTS Window and Dialog Box Reference” for descriptions of each SunVTS window and dialog box.
4.1 Getting Started with the SunVTS CDE UI

This section describes how to use the fundamental features of the SunVTS CDE UI to perform diagnostic testing on a system. For information about using more advanced features, see “Using Additional Features with the SunVTS CDE UI” on page 4-18.

4.1.1 The SunVTS CDE UI Main Window

When you start the SunVTS CDE user interface, the SunVTS CDE main window is displayed (FIGURE 4-1). SunVTS is in an idle state with all testing options set to default values.

The procedures in this chapter explain how to use the CDE main window:

- “To Configure SunVTS for a Test Session” on page 4-4
- “To Run, Monitor, and Stop a Test Session” on page 4-14
- “To Review and Reset Test Session Results” on page 4-15
FIGURE 4-1  SunVTS CDE Main Window

Note – See Appendix A “SunVTS Window and Dialog Box Reference” for details about each main window item.
▼ To Configure SunVTS for a Test Session

1. Identify the current state of SunVTS in the Status panel (FIGURE 4-2).

![FIGURE 4-2 CDE Status panel](image)

The following information is displayed in the Status panel:

- **Hostname**—indicates the name of the system under test
- **Model**—indicates the model of the system under test
- **Testing status**—provides the following status of SunVTS:
  - ds_idle—the deterministic scheduler is invoked, but is not testing
  - ds_running—the deterministic scheduler is invoked and is running a sequence
  - ds_suspended—the deterministic scheduler is invoked and a sequence is suspended
  - Idle—no testing is taking place
  - Replay—a previously recorded test session is displayed
  - Stopping—is momentarily displayed when a test session stops
  - Suspend—a test session is suspended
  - Testing—a test session is running
- **System passes**—displays the total number of successful system passes (a system pass is when all tests have been run once).
- **Cumulative errors**—the total number of errors from all tests
- **Elapsed test time**—indicates the total number of hours, minutes, and seconds that elapsed during testing.
- **Last Option File**—displays the name of the last option file that was accessed.
- **AC Coverage**—displays the type of Auto Configuration coverage level that was selected (either confidence, comprehensive, or no_coverage when the AC feature is not in use).
2. Select a test mode from the Test Mode panel (FIGURE 4-3):

![Select Test Mode]

**FIGURE 4-3** CDE Test Mode Panel

About test modes:

- Connection test mode—provides a low-stress, quick testing of the availability and connectivity of selected devices. These tests are non-intrusive, meaning they will release the devices after a quick test, and they will not place a heavy load on system activity.

- Functional test mode—provides more robust testing of your system and devices. It will use your system resources for thorough testing and it assumes that no other applications are running.

- Auto Config mode—opens the Automatic Configuration dialog box which provides access to the Automatic Configuration feature. The Automatic Configuration feature simplifies the test session configuration by assigning a predetermined set of test options. See “Using the Automatic Configuration Feature” on page 4-19 for instructions on using this feature.

**Note** – As you change test modes, the tests that are selectable in the System Map change.
3. Specify the System Map display mode (logical or physical):

![System Map Display Mode](image)

**FIGURE 4-4** CDE System Map (Logical View, Collapsed)

*About display modes:*

The devices that SunVTS identified as testable devices on your system are listed in the System Map (FIGURE 4-6). You control the way that SunVTS displays these devices by selecting one of the following:

- Logical Mapping—organizes the devices, according to their function, into groups. For example, SCSI disk, SCSI tape, and SCSI CD-ROM drives are placed in the SCSI-Devices group. You can focus your testing on a specific device, device group, or on all of the groups on the system.

- Physical Mapping—shows the exact location of each device on the system in relation to how the devices are connected to each other. If you are testing a single-board type system, each device is shown under the system board. Multi-board type systems show each device under the board (for example, board0, board1, and so on) to which the device is attached. For example, if you have multiple disk drives connected to different disk interfaces, each disk would be displayed under the respective interface. From Physical Mapping, you can determine the actual location of each device. When possible, the board number and controller type for the device are also displayed.
FIGURE 4-5 Logical and Physical Mapping Examples

*How to do it:*
Select the Physical or Logical button.
4. Expand the System Map to view selectable devices.

**FIGURE 4-6**  CDE System Map (Logical View, Expanded)

*About devices in the System Map:*
When SunVTS is started, most of the devices in the System Map are *collapsed*, meaning individual devices are grouped together and hidden from view under a device category. A “+” (plus) indicates that the device group is collapsed. A “−” (minus) indicates that the device group is *expanded* so you see each device for a given category.

*How to do it:*
Use the following methods to open the System Map:
- Use the View→Open System Map command from the menu bar to completely expand all the groups.
- Click on the “+” next to a specific group in the System Map to expand an individual group.
5. Select the devices that you want to test.

**FIGURE 4-7** Devices Selected in the System Map

*About selecting devices:*

A checkmark next to a device in the System Map indicates that device is selected. Depending on the devices on your system, and the test mode that you select, SunVTS selects certain devices by default.

*How to do it:*

a. **Select your devices using the buttons in the Device Selection panel:**
   - Default—selects the SunVTS default selected devices
   - None—deselects all devices
   - All—selects all devices
   - Intervention—required before you can select tests that require special device preparation.

   **Note** – Any device that requires your intervention before the test can run (such as loading media for tape, CD-ROM, and diskette tests), also requires that you notify SunVTS that you have performed this action by selecting the Intervention checkbox. You cannot select any intervention mode tests until you select this checkbox.

b. **Refine the selected devices by clicking on the checkmark box next to a device or device group.**
6. **Modify the system-level test options (if desired).**

*About test options:*

SunVTS is ready to test each device once you select it. There are, however, testing options that you can modify that alter the way tests run to suit your testing needs. There are three levels where you control test options:

- **System-level options**—control the testing attributes of all devices. This is the highest level, applying all your options globally. When you modify options at this level, the option settings are propagated down to the group-level and device-level options.

- **Group-level options**—control the testing attributes of all the devices in the group. Settings made at this level propagate down, setting all the options in the levels in the group.

- **Device-level options**—control the testing of a single, specific device. Some of these options can also be applied to the other like-devices with Apply to All pull-down menus.

The order that you apply the system-level, group-level, and device-level options is important. Start by assigning the system-level options, then assign the group-level options, and finish with the device-level options. Otherwise, if you make lower-level option settings, then higher level option settings, the higher-level settings will propagate down and undo your lower-level settings. An alternative to this approach is to use locks and overrides to protect lower level settings. See “Preserving Test Options with Locks and Overrides” on page 4-24.

---

**Note** – System-level, group-level, and device-level options are only available when Functional Test Mode is selected. Most of these options are grayed-out and not available for Connection Mode testing.
How to do it:
Access the system-level options from the Options menu in the Menu Bar (FIGURE 4-8).

The following dialog boxes provide system-level options that define how the entire test session runs.

- **Thresholds**—provides access to test session limits such as the maximum number of system passes and the maximum test session time.
- **Notify**—provides access to set up testing notification through email.
- **Schedule**—provides access to auto start, single pass, and concurrency options.
- **Test Execution Options**—allows you to define how a test session runs. For example, you can select stress mode which enables the most rigorous testing. You can set the Max errors value to define the maximum number of allowable errors before stopping the test (0=continue to run on infinite errors).
- **Advanced**—provides overrides and locks that control which option settings (system-level, group-level, or device-level) take precedence.
- **Option Files**—creates or selects and option file which can be loaded, stored, or removed.

**Note** — These dialog boxes are described in detail in Appendix A “SunVTS Window and Dialog Box Reference”.

**Note** — To increase or decrease a numeric value in a SunVTS CDE dialog box, you can either use the up or down arrows, or type a new value in the text box and press Return. Press Apply to apply all dialog box changes.
7. Modify group-level and device-level options (if desired).

**Figure 4-9** Test-Specific Options

About group-level and device-level options:

Group-level and device-level options are testing attributes that accompany each test and pertain to a specific device (or device group) only.

How to do it:

Access the group-level and device-level menus by placing your pointer over a device (or device-group) and right-clicking on it.

A menu appears offering access to the following dialog boxes (FIGURE 4-9):

- **Status**—displays a list showing each test instance and a test pass and fail value for each instance.

- **Test Parameter Options**—Shows device configuration information and provides the controls for defining specific test options. This menu is different for each kind of test. For example, the Test Parameter Options for the memory test (**pmemtest**) allow you to specify the amount of memory to test, while the network test (**nettest**) provides a setting to define a target host for test packets. Refer to the *SunVTS 4.4 Test Reference Manual* for descriptions of all the Test Parameter Options. Once you change a Test Parameter Option, apply the change to the desired level:

  - **Within Instance**—applies the option settings to this test instance (test instance 1 for example) with:
    - **Apply**—to this device only.
• Apply to Group—to all the same instances, of this device type, in the group.
• Apply to All—to all the same instances of the same device type on the system.

■ Across All Instances—applies the option settings to all test instances (for example, instance 1 and 2) with:
  • Apply—for all test instances for this device.
  • Apply to Group—for all test instances for the same device type in the group.
  • Apply to All—for all test instances for the same device type on the system.

See “Test Parameter” on page A-20 for more information.

■ Test Execution Options—allows you to define how a test runs. For example, you can select stress mode which enables the most rigorous testing. You can set the Max errors value to define the maximum number of allowable errors before stopping the test (0=continue to run on infinite errors). The options in this menu are the same for each kind of test.

■ Test Advanced Options—Provides a setting to “lock” the option settings for an individual device so that the system level setting will not affect the option setting for this test. See “Preserving Test Options with Locks and Overrides” on page 4-24 for more details.

■ Schedule Options (group level only)—sets the maximum number of tests you want to run at the same time in the same group.

**Note** – For descriptions of the options presented in these dialog boxes see, “SunVTS Dialog Boxes” on page A-9.
To Run, Monitor, and Stop a Test Session

1. **Start the test session by clicking on the Start Button.**
   Depending on how you configured the options in the Test Execution menus, testing will continue until:
   - a test error is detected (this is the default behavior). If you enter a value for Run On Error, SunVTS continues to run until the specified number of errors is reached.
   - testing has reached the Max Passes value. The default is to run indefinite test passes. When individual test passes are complete, SunVTS continues to display the status testing for 5 seconds. If you do not select additional devices to test in the 5 second interval, SunVTS enters an idle state.
   - testing has reached the Max Time value. The default is to run indefinitely.
   - you select the Stop button.

2. **Monitor the overall test session status by watching the Status panel.**
   The Status panel indicates that a test session is running by displaying testing for the Testing status. The system passes, cumulative errors, and elapsed test time will increment.

3. **Monitor specific tests by watching the System Map.**
   Watch for:
   - An asterisk—displayed next to each device indicating the device that is currently under test. Depending on how you configured SunVTS (with the System Concurrency option), single or multiple devices are tested concurrently.
   - Colors—Indicate the state of devices as follows:
     - Black—indicates that the device is not tested, or the first pass is not complete.
     - Green—indicates that at least one test pass completed with no errors detected.
     - Red—indicates that at least one error was detected.

4. **Check for test messages by watching the Test Message panel.**
   The Test Message panel displays test messages under the following circumstances:
   - When a test error occurs.
   - If you enable trace mode (from the Commands→Trace test menu bar selection) and set the trace to display in the window, all of the test system calls are displayed.
   - If you enable verbose mode (through the Test Execution dialog box), verbose messages are displayed.

5. **Stop the test session (if desired) by clicking the Stop button.**
To Review and Reset Test Session Results

1. Review the logs.

   About logs:

   SunVTS provides access to four log files:

   ■ SunVTS test error log—contains time-stamped SunVTS test error messages. The
     log file pathname is /var/opt/SUNWvts/logs/sunvts.err. This file is not
     created until a SunVTS test failure occurs.

   ■ SunVTS kernel error log—contains time-stamped SunVTS kernel and SunVTS
     probe errors. SunVTS kernel errors are errors that relate to running SunVTS, and
     not to testing of devices. The log file pathname is /var/opt/SUNWvts/logs/
     vtsk.err. This file is not created until SunVTS reports a SunVTS kernel error.

   ■ SunVTS information log—contains informative messages that are generated when
     you start and stop SunVTS test sessions. The log file pathname is
     /var/opt/SUNWvts/logs/sunvts.info. This file is not created until a
     SunVTS test session runs.

   ■ Solaris system message log—is a log of all the general Solaris events logged by
     syslogd. The pathname of this log file is /var/adm/messages.

   How to do it:

   a. Click the Log button.

      The Log file window is displayed.

   b. Specify the log file that you want to view by selecting it from the top button in
      the Log file window.

      The content of the selected log file is displayed in the window.

   c. With the three lower buttons you can:

      ■ Print the log file—a dialog box appears for you to specify your printer options
        and printer name.

      ■ Delete the log file—the file remains displayed, but will be gone the next time you
        try to display it.

      ■ Close the Log file window—the window is dismissed.

   Note – Take the length of the log file into consideration before you print it.

2. Interpret SunVTS messages

   There are many messages for each of the many tests that run under SunVTS. For this
   reason, it is difficult to document the implication of each message that you might
   see. Most messages contain all the explanatory text that is possible for each event
   that is encountered. Some messages are information messages (INFO, VERBOSE,
WARNING) which do not represent an error, and some messages are error messages (ERROR and FATAL), indicating that the test detected a failure. This section explains generic test message information.

SunVTS information message example:

```
04/24/00 17:19:47 systemA SunVTS4.4: VTSID 34 disktest.VERBOSE
c0t0d0: "number of blocks 3629760"
```

SunVTS error message example:

```
05/02/00 10:49:43 systemA SunVTS4.4: VTSID 8040 disktest.
FATAL diskette: "Failed get_volmgr_name()"
Probable_Cause(s):
(1) No floppy disk in drive
Recommended_Action(s):
(1) Check the floppy drive
```

Whenever possible, the error message supplies a message type (TABLE 4-1), followed by the message text, one or more probable causes, and one or more recommended corrective actions.

The following table describes the types of messages you might encounter. All messages are displayed in the Message panel, and most are logged in one of the SunVTS logs (Info or Error).

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Log file</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td>Info log</td>
<td>Displayed when a non-error test event occurs.</td>
</tr>
<tr>
<td>ERROR</td>
<td>Error and Info logs</td>
<td>Displayed when a test detects an error, often an indication of a problem with a specific function or feature of the device under test.</td>
</tr>
<tr>
<td>FATAL</td>
<td>Error and Info logs</td>
<td>Displayed when a test detects a severe error that might cause the test to exit; such as a failure to open a device. These errors are indicative of hardware failures.</td>
</tr>
<tr>
<td>VERBOSE</td>
<td>Not logged</td>
<td>Test progression messages that are displayed when the verbose feature is enabled.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Info log</td>
<td>Displayed when something affects the test that is not an error; such as a device that is busy.</td>
</tr>
</tbody>
</table>
You can write scripts that watch for certain SunVTS events as they are logged in the log files, and which trigger an action when a particular message string occurs. If you plan to do this, refer to the following SunVTS message syntax and descriptions (TABLE 4-2).

SunVTS Message Syntax:

```
<timestamp> <hostname> "SunVTS<version_id>:\" [VTSID <vts_msgid>
<modulename> [. <submodulename>] [. <instnum>][ (#P)].<vts_msgtype>]
[<device_pathname>:] <msg_text>
```

<table>
<thead>
<tr>
<th>Message Item</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;timestamp&gt;</code></td>
<td>Represents the date in \textit{mm/dd/yy} format, and the time in \textit{hh:mm:ss} format, when the message was logged.</td>
</tr>
<tr>
<td><code>&lt;hostname&gt;</code></td>
<td>Name of the system under test.</td>
</tr>
<tr>
<td>\textbf{SunVTS&lt;version_id&gt; }</td>
<td>Displays the string \textit{SunVTS} followed by the version of SunVTS, for example \textit{SunVTS4.4}.</td>
</tr>
<tr>
<td>VTSID &lt;vts_msgid&gt;</td>
<td>Displays the string \textit{VTSID} followed by the ID of the message.</td>
</tr>
<tr>
<td><code>&lt;modulename&gt;</code></td>
<td>Name of the module (usually the test name or \textit{vtsk}) that generated the message.</td>
</tr>
<tr>
<td><code>&lt;submodulename&gt;</code></td>
<td>Name of the subtest, if applicable.</td>
</tr>
<tr>
<td><code>&lt;instnum&gt;</code></td>
<td>Number of the test instance.</td>
</tr>
<tr>
<td>(#P)</td>
<td>Processor ID for which the test is bound (applicable if a test is assigned to a specific processor with the processor affinity option).</td>
</tr>
<tr>
<td>&lt;vts_msgtype&gt;</td>
<td>Identifies the message with one of the following message types: \textit{ERROR}, \textit{FATAL}, \textit{INFO}, \textit{VERBOSE}, or \textit{WARNING}.</td>
</tr>
<tr>
<td><code>&lt;device_pathname&gt;</code></td>
<td>Name of the device under test.</td>
</tr>
<tr>
<td><code>&lt;msg_text&gt;</code></td>
<td>The text of the message. This often includes the error, a probable cause, and a recommended action.</td>
</tr>
</tbody>
</table>

\textbf{Note} – The message syntax changed as of SunVTS 4.0. For the old message syntax information, see “Frequently Asked Questions” on page B-1. In a future version of SunVTS, the old message format will no longer be supported. Update any scripts that rely on the old message format.
3. Reset the test session results (if desired).
When you are done reviewing the information in the main window, you can clear
the current results by clicking on the Reset button. This resets the information in the
Status panel. This does not reset your test options.

4.2 Using Additional Features with the
SunVTS CDE UI

This section describes additional SunVTS features using the SunVTS CDE user interface:
- “To Use the Automatic Configuration Feature” on page 4-19
- “Connecting to Another Host” on page 4-21
- “Using the Email Notification Feature” on page 4-22
- “Controlling the Size of the Log Files” on page 4-22
- “Tracing a Test” on page 4-23
- “Preserving Test Options with Locks and Overrides” on page 4-24
- “Scaling Your Test Session” on page 4-25
- “Using the Debugging Features” on page 4-26
- “Saving a Test Session Configuration for Repeated Use (Option Files)” on page 4-
  27
- “Using the Auto-Start Feature” on page 4-28
- “Suspending and Resuming a Test Session” on page 4-29
- “Recording and Replaying a Test Session” on page 4-29
4.2.1 Using the Automatic Configuration Feature

The Automatic Configuration feature simplifies the SunVTS configuration steps by automatically assigning a predetermined set of test options. This feature provides the following benefits:

- Consistent testing—as you test the system from time to time, you know that the same test options are applied. You also get diagnostic consistency when you test multiple systems of the same platform type.
- Reliable testing—provides assurance that any errors that you might encounter are not due to incorrectly set test options.
- Simplified configuration—there are many options for the numerous SunVTS tests. The Automatic Configuration feature takes the guesswork out of assigning these options.
- Time Saving—You can select the Automatic Configuration feature without manually setting the options and start testing right away.

▼ To Use the Automatic Configuration Feature

1. Prepare any “intervention” devices and select the Intervention checkbox.
   See “Preparing Devices for Testing” on page 3-4.

2. Select Auto Config from the Select Test Mode panel.
   The Automatic Configuration dialog box is displayed (FIGURE 4-10).

3. Select one of the following choices from the Automatic Configuration dialog box:
   - Comprehensive—sets all the test options for thorough testing. All applicable functional tests are enabled. The test session validates the full functionality of the system and provides you with assurance that the system is hardware fault free.
   - Confidence—sets all the test options such that there is limited functional test coverage as compared to the Comprehensive level of coverage. The Confidence level testing verifies the main functionality of the system in a shorter amount of time.
4. Click on Select in the dialog box.
   SunVTS applies the predefined options and is ready to test selected devices.

5. (Optional) Select or deselect the devices that you want to test in the System Map.
   This step is optional. For full system testing, use the devices that are selected by the
   Automatic Configuration feature.

6. Click the Start button in the SunVTS main window.
   The test session runs with the predetermined set of options based on the level of
   coverage (comprehensive or confidence) that you selected. The AC Coverage
   (Confidence or Comprehensive) is displayed in the Status panel.
4.2.2 Connecting to Another Host

You can connect the SunVTS user interface on your local system to a SunVTS kernel that is running on another system in your network. Once you are connected to the remote system, all of the controls in the CDE UI control the testing of the remote system.

▼ To Connect to Another Host

1. **Make sure that the SunVTS kernel is running on the remote system.**
   You can do this in several ways. You can remote login (using `rlogin` or `telnet`) to the remote system and run the `vtsk` command.

   **Note** – On the remote system, you must login (or switch user) as a user that has SunVTS privileges (superuser by default) before you can start the SunVTS kernel (`vtsk`).

   **Note** – You can only connect to a system running the same version of SunVTS.

2. On the local system (the system running the SunVTS UI), click on the Connect to Host button.
   The Connect to Host dialog box is displayed.

3. **Specify the name of the remote system to which you want to connect.**
   Enter the hostname in the Connect to Host field. As you connect to various remote systems, SunVTS keeps track of those systems and displays them in the Hostname List. You can reconnect to one of those hosts by double-clicking on the host name in this list. This list is only maintained during your current SunVTS session. When you quit SunVTS, the Hostname List is cleared.
   Any number of UIs can connect to a SunVTS kernel and each UI displays a synchronous view of SunVTS.

4. **Click Apply in the Connect to Host dialog box.**
   The SunVTS UI now controls the SunVTS testing of the remote system. The remote system hostname is displayed in the Status panel, confirming the connection.
4.2.3 Using the Email Notification Feature

You can have SunVTS send the test status messages to you using email.

▼ To Enable Email Notification

1. Select Notify from the Options menu in the Menu bar. The Notify Options dialog box is displayed.

2. Select one of the following from the Send Email pull-down menu:
   - disabled—disables the email notification feature.
   - now—send email immediately one time, then disable the notification feature.
   - on error—send email when an error occurs.
   - periodically—send email at regular intervals as specified in the Log Period.
   - on_error&periodically—send email periodically and when an error occurs.

3. Enter an email address in the email address field.

4. If you selected Periodically or on_error&periodically, specify the log period in minutes (1-99999).

5. Click on Apply.

You will receive the SunVTS information messages in email based on your notification criterion.

4.2.4 Controlling the Size of the Log Files

The log file sizes of the SunVTS test error log (/var/opt/SUNWvts/logs/sunvts.err), the SunVTS kernel error log (/var/opt/SUNWvts/logs/vtsk.err) and the information log (/var/opt/SUNWvts/logs/sunvts.info) are each limited to a maximum size of 1 Mbyte by default. When the log file reaches the maximum size, the content is moved to a file called logfilename.backup. Additional events are added to the main log files. If the log file reaches the maximum size again, the content is moved to the backup file, overwriting the earlier backup file content. Only one backup file is maintained for each log file.

You can modify the log file maximum size specification.

▼ To Modify the Log File Size Limits

1. Select Option→Thresholds from the Menu bar. The Threshold Option dialog box is displayed.
2. **Use the arrows to increase the Max System Log Size number.**
   Select a number from 1 to 5 (Mbytes). For example, if you choose 5 Mbytes, SunVTS will use up to 30 Mbytes for log files (there are three log files, each may also have an equal sized backup file).

3. **Click on Apply.**

### 4.2.5 Tracing a Test

You can use the Trace test option to create a log of every system call made when a test is running. This feature logs the system calls using the standard UNIX command `truss`. The trace messages logged by this feature give you a powerful debugging tool for isolating the specific cause of an error.

#### To Enable Tracing

1. **Select Commands→Trace test from the Menu bar.**
   The Trace Test window is displayed.

2. **Choose a test to trace from the list of test names and then select Apply, or double-click a test name to enable tracing and close the window.**
   When you select a test, system call tracing is enabled immediately. If the test is already running when you select it, tracing begins immediately and the trace test messages appear in the SunVTS console window.

   **Note** – You can only select one test at a time to trace when using the SunVTS CDE user interface.

   **Note** – When using the Physical map view, you can only see one level in the hierarchy (such as one controller on a system board). Therefore, some devices that are several levels down are not available to trace. Use the Logical view to select tracing for these devices.

3. **Select File and click Apply to write the trace test messages to a file called `/var/opt/SUNWvts/logs/sunvts.trace`.**

#### To Disable Tracing

1. **Bring up the Trace Test window again, click on the highlighted test name, and click Apply.**
   This action deselects the test and disables tracing.
4.2.6 Preserving Test Options with Locks and Overrides

With locks and overrides you can preserve or override the options you set at the system level, group-level, and device-level (see “Modify the system-level test options (if desired)” on page 4-10).

4.2.6.1 Locks

Normally, when you change an option setting at the system level or group-level, the new option setting propagates down to all lower levels. Enabling the lock prevents an option setting made at a higher level from affecting the lower-level option setting.

Note – The override option nullifies lower-level locks.

▼ To Set (or Unset) a Lock

1. Open the Test Advanced Options dialog box from the group-level or device-level you want to lock.
   To access this dialog box, place your pointer over the group or device and right-click. Then select Test Advanced Options from the menu.

2. Click the Enable button to set the lock (or disable button to unset the lock).
   With the lock set, you can make option setting changes at higher levels without affecting the option settings of the locked device.

4.2.6.2 Overrides

You can use overrides to void the lock protection. Setting the system-level override nullifies all locks, and setting a group-level override nullifies all the locks below that group.

▼ To Set (or Unset) an Override

1. Open the Advanced Option dialog box at one of the following levels:
   - System level—select Option→Advanced from the Menu bar.
   - Group level—place your pointer over the group and right-click. Then select Test Advanced Options.

2. Enable the Override setting (or disable the Override setting to unset it).

3. Click Apply.
Scaling Your Test Session

You can use a combination of options to scale (increase or decrease testing intensity) to meet your diagnostic needs. For example, you can modify test options so that each test instance runs simultaneously, thus increasing the stress level for a single or multiprocessor system. The following procedures can be used individually or in combination to scale the test session.

▼ To Modify the Number of Test Instances

You can scale your test session by running multiple copies of the same test on your devices. Each copy is called a test instance. Each test instance is a separate process of the same test. The number of test instances can be set at the system level, group level, and the device level as follows:

1. Open the Test Execution dialog box at one of the following levels:
   - System level—select Option→Test Execution from the Menu bar.
   - Group level—place your pointer over the group and right-click. Then select Test Execution Options.
   - Device level—place your pointer over the device and right-click. Then select Test Execution Options.

2. Use the arrow buttons to increase or decrease the number of instances.

3. Click Apply.

▼ To Modify Test Concurrency Options

The test concurrency option sets the number of tests that run at a given time during a test session. You can set this value to one to run one test at a time, or increase the test concurrency value thus increasing the stress level of your test session.

There are two options in the Schedule Option dialog boxes (at the system level and group level) to scale your test session:

- System Concurrency—sets the maximum number of tests that you can run at the same time at the system level. It overrides the Group Concurrency option.
- Group Concurrency—sets the maximum number of tests to run simultaneously in the same group. This option is available at the system level and the group level.

1. Open the Schedule dialog box from one of the following levels:
   - System level—select Option→Schedule from the Menu bar.
   - Group-level—place your pointer over the group and right-click. Then select Schedule Options.

2. Use the arrow buttons to increase or decrease the System Concurrency and Group Concurrency values.
3. Click Apply.

To Bind a Test to a Processor with the Processor Affinity Option (for Multiprocessor Systems)

By default, the Solaris kernel assigns each test instance to whichever processor is available at the time. On multiprocessor systems, you can bind (assign) a test instance to a particular processor as follows:

1. Open the Test Execution dialog box at one of the following levels:
   - System level—select Option→Test Execution from the Menu bar.
   - Group-level—place your pointer over the group and right-click. Then select Test Execution Options.
   - Device-level—place your pointer over the device and right-click. Then select Test Execution Options.

Note – The Processor Affinity field is only displayed on multiprocessor systems.

Note – The Processor Affinity option is not available for processor tests such as cputest and fputest. These tests are associated with each individual processor on your system and you cannot bind these tests to a different processor.

2. Select a Processor from the Processor Affinity field.
3. Click Apply.

4.2.8 Using the Debugging Features

You can enable certain options that cause the SunVTS test session to output more test data than when you run the session with the default option values. The following procedures describe how to enable these features.

To Enable (or Disable) Verbose and Core File Options

1. Open the Test Execution dialog box at one of the following levels:
   - System level—select Option→Test Execution from the Menu bar.
   - Group-level—place your pointer over the group and right-click. Then select Test Execution Options.
   - Device-level—place your pointer over the device and right-click. Then select Test Execution Options.
2. **Enable (or disable) one or more of the following options:**
   - **Verbose**—displays verbose messages indicating when the test is starting and stopping during the test session.
   - **Core File**—when enabled, creates a core file when a test session results in a core dump. The core file is called `sunvts_install_dir/bin/core.testname.xxxxxx`, where `testname` is the test that dumped the core, and `xxxxxx` is a character string generated by the system in order to make the file name unique.

**Note** – The Trace feature also provides additional test data. See “Tracing a Test” on page 4-23.

### 4.2.9 Saving a Test Session Configuration for Repeated Use (Option Files)

You can use the Option Files feature to save the current set of selected devices and test options for reuse. This is a convenient feature when you plan to the same test session configuration over and over again.

The configuration information is saved in a filename of your choice in the `/var/opt/SUNWvts/options` directory.

**Note** – Do not manually edit any option file. Unnecessary or spurious characters in the option file can cause unexpected behavior when you use it.

▼ **To Create an Option File**

1. **Configure SunVTS for the test session that you want to save.**
   - See “To Configure SunVTS for a Test Session” on page 4-4.
2. **Select Options→Option files from the Menu bar.**
   - The Option Files dialog box is displayed.
3. **Specify an option file name in the Option File field.**
4. **Click on Store.**
5. **Repeat Step 1 through Step 4 for each test session configuration you want to save.**
6. **Click Close in the Option Files dialog box.**
   - The Option Files dialog box is closed, and your test session configurations are saved for future use.
To Load an Option File

**Note** – Loading an option file that was created on another system is permitted, but you must make sure that the configuration is valid for the system you plan to test.

**Note** – Do not load an option file that was created in a 64-bit environment into a 32-bit environment.

1. Select Options→Option files from the Menu bar.
   The Options Files dialog box is displayed.

2. Select an option file from the Option file list.

3. Click Load.
   The test session configuration is loaded into SunVTS and the name of the option file is displayed in the Status panel. You can use this configuration, or modify it before you start the test session.

To Remove an Option File

1. Select Options→Option files from the Menu bar.
   The Options Files dialog box is displayed.

2. Select the option file that you want to delete from the Option File List.

3. Click Remove.

4. Click Close.

4.2.10 Using the Auto-Start Feature

You can use the auto-start feature, along with saved option files, to simplify the process of configuring a test session and running it.

To Configure SunVTS to use the Auto-Start Feature

1. Select Options→Schedule from the Menu bar.
   The Schedule dialog box is displayed.

2. Enable the Auto Start setting in the Schedule dialog box.
3. Create an option file as described in “To Create an Option File” on page 4-27. The option file that you create is configured to use the auto-start feature.

▼ To Use the Auto-Start Feature

1. Select Commands→Quit SunVTS→UI and Kernel. You must quit SunVTS and restart it for the auto-start feature to work.

2. Use the following command to restart SunVTS from the command-line, specifying the option file that you created:

```
# /opt/SUNWvts/bin/sunvts -o option_file
```

SunVTS displays the main window and automatically starts the test session.

4.2.11 Suspending and Resuming a Test Session

You can suspend a test session while it is running. For example, you might want to look at messages on the Message panel that have scrolled out of view, or you may want to view and print a log file.

▼ To Suspend and Resume a Test Session

1. Select Commands→Suspend from the Menu bar. “Suspended” is displayed in the Status panel, and the test session pauses until you resume it.

2. Select Commands→Resume from the Menu bar. “Testing” is displayed in the Status panel, and the SunVTS kernel resumes the suspended test session.

4.2.12 Recording and Replaying a Test Session

You can use the Record and Replay feature to record a SunVTS test session. Only one test session recording is saved at a time.

The events are recorded in a file called /var/opt/SUNWvts/vts_replay_file. Once a test session is recorded, you can use the recorded events to drive the SunVTS kernel so it reproduces the recorded sequence of events at a later time.
Note – The Record and Replay feature closely reproduces the sequence of events, but it cannot reproduce the time periods of these events because the execution times vary from one run to another.

Note – Do not edit the /var/opt/SUNWvts/vts_replay_file.

▼ To Record and Replay a Test Session

1. Configure SunVTS for the test session that you want to run.
   See “To Configure SunVTS for a Test Session” on page 4-4.

2. Select Commands→Start testing with record from the Menu bar.
   The test session runs, and the events are recorded. When testing stops, the recorded session is available to replay.

3. Select Commands→Replay to replay the test session.
   The kernel reruns the same tests, with the same configuration that you specified in Step 1.

Note – During the replay, the kernel is actually rerunning the tests, not just re-displaying the recorded session.
4.3 Scheduling Test Sequences With the Deterministic Scheduler

SunVTS provides a Deterministic Scheduler that you can use to define what tests run and in what order. If you do not use this feature, selected tests run in an order that is determined by SunVTS.

4.3.1 Deterministic Scheduler Overview

The Deterministic Scheduler is available as a dialog box from the SunVTS CDE interface menu-bar area.

The following list provides an overview of the steps you perform to start, run, and quit the Deterministic Scheduler feature. Detailed instructions follow.

1. Start SunVTS with the SunVTS CDE user interface.
2. Start the Deterministic Scheduler.
3. Create one or more tasks. A task is a SunVTS test session configuration (one or more selected SunVTS tests, test options, and specified test mode).
4. Create the sequence. A sequence is a group of tasks specified to run in a certain order.
5. Define the number of times (loops) that sequence runs.
6. Start the sequence.
7. When the sequence is done, reset the Deterministic Scheduler if desired.
8. Quit the Deterministic Scheduler feature.

4.3.2 Getting Started With the Deterministic Scheduler

1. Start SunVTS with the SunVTS CDE user interface as described in “Starting SunVTS” on page 3-1.
2. Start the Deterministic Scheduler by selecting DSched → start DS from the SunVTS menu bar.

The Deterministic Scheduler Dialog box is displayed (FIGURE 4-11).
Note – When you start the Deterministic Scheduler, many of the commands from the main SunVTS window such as Start, Stop, Resume, Suspend, Record, Replay, Load, and Set are not permitted. When you stop the Deterministic Scheduler, these SunVTS features become functional.

Note – The Help button displays a dialog box with Deterministic Scheduler information and instructions.

3. Define your task(s) as described below:
a. **In the Deterministic Scheduler dialog box, click on the Edit button.**

The Deterministic Scheduler displays the Task Manager panel and shows a list of existing tasks (if any have been created) in the Available Tasks list. You can use existing tasks or create new tasks. If this is the first time that the Deterministic Scheduler is used, you must create your own.

b. **In the SunVTS main window, configure a test session (select one or more devices and your desired test mode).**

If you assign more than one test to a task, the order of the tests within this task will be determined by SunVTS. If you want to control the order of every test, assign only one test for each task.

When the Deterministic Scheduler is started, it changes the default values of Max System Passes from 0 (run indefinitely) to 1 (run one pass). This is necessary so that each task only runs selected tests once and proceeds to run subsequent tasks in the sequence.

c. **In the Deterministic Scheduler dialog box, enter a task name.**

d. **Click on Store in the Task Manager panel.**

Your task appears in the Available Task list.

e. **Repeat Step a through Step d to create additional tasks.**

f. **To see the tests configured for a particular task, select the task from the Available task list and press Load.**

The SunVTS main window shows the SunVTS test configuration that is associated with the selected task.
g. If you want to modify a task: select it; load it; change the test configuration in the SunVTS main window; and press Store in the Task Manager panel.

h. If you want to delete a task, select it and press Remove in the Task Manager panel.
   The task is removed from the Available Task list.

4. Define the sequence as follows:
   a. Select a task from the task list.
   b. Press the Insert button.
      The task is added to the sequence list.
   c. Repeat the previous steps until all desired tasks are added to the sequence list in the order that you want them to run.
      You can add the same task more than once.
      When you begin testing, the tasks run from the top of the list down.
   d. If you want to remove a task from the sequence list, select it and press Delete.
   e. To save the sequence for future use, enter a name in the Sequence name field and press Store in the Task Manager panel.
      The sequence will be saved for easy retrieval for future testing.
f. With the Sequence selected, press the Run button.

The right-hand panel displays the Sequence Runner panel (FIGURE 4-14), providing access for you to define the number of times (loops) for the sequence to run and to start running the sequence.
5. Define the sequence loops.
   a. Increment or decrement the Total Loop value to the desired number of times you want the sequence to run.

6. Press the Start button to start the sequence.
   While testing is underway you can:
   ■ monitor the test progress in the main SunVTS window. All test results are logged in the SunVTS log files.
   ■ close the Deterministic Scheduler dialog box by pressing the close button or by selecting Commands→Quit Options→Quit UI only from the Deterministic Scheduler dialog box. Testing will continue, and results will be displayed in the SunVTS main window. You can reopen the Deterministic Scheduler dialog box from the SunVTS main window.
   ■ suspend and resume the sequence by pressing the suspend and resume buttons in the Deterministic Scheduler dialog box.

7. Use the Reset button to reset the SunVTS main window and the Deterministic Scheduler.
   The SunVTS main window test statistics and the Deterministic Scheduler current loop count are reset.
8. Quit the Deterministic Scheduler when you are done by selecting Commands→Quit Options→Quit DS and UI.

The Deterministic Scheduler and the Deterministic Scheduler dialog box are dismissed.
Using the SunVTS OPEN LOOK User Interface

This chapter describes how to run a test session using the SunVTS OPEN LOOK UI. The procedures are written in a step-by-step form so you can use them to become familiar with SunVTS using the SunVTS OPEN LOOK UI. This chapter is divided into the following sections:

- “Getting Started with the SunVTS OPEN LOOK UI” on page 5-2
- “Using Additional Features with the SunVTS OPEN LOOK UI” on page 5-12

Note – The SunVTS OPEN LOOK user interface does not support the latest SunVTS features and will be discontinued when the OPEN LOOK environment is discontinued in the Solaris operating environment. When this occurs, the OPEN LOOK tests (sundial and sunbuttons) will also be discontinued. For full feature support, use the SunVTS CDE or TTY interface. Refer to the Solaris “End-of-Software Support Statements” section of the Solaris operating environment release notes for the latest end of support news.

Note – This chapter assumes that you have already performed the following procedures:
- Installed SunVTS as described in Chapter 2 “Installing and Removing SunVTS”
- Started SunVTS as described in Chapter 3 “Starting SunVTS”
- Prepared your system for testing as described in Section 3.4 “Preparing Devices for Testing”

See Appendix A “SunVTS Window and Dialog Box Reference” for descriptions of each SunVTS window and dialog box.
5.1 Getting Started with the SunVTS OPEN LOOK UI

This section describes how to use the fundamental features of the SunVTS OPEN LOOK UI to perform diagnostic testing on a system. For information about using more advanced features, see “Using Additional Features with the SunVTS OPEN LOOK UI” on page 5-12.

The procedures in this section explain the following:

■ “The SunVTS OPEN LOOK UI Main Window” on page 5-2
■ “To Configure SunVTS for a Test Session” on page 5-3
■ “To Run, Monitor, and Stop a Test Session” on page 5-8
■ “To Review and Reset Test Session Results” on page 5-10

5.1.1 The SunVTS OPEN LOOK UI Main Window

When you start the SunVTS OPEN LOOK user interface, the SunVTS OPEN LOOK main window is displayed (FIGURE 5-1). SunVTS is in an idle state with all testing options set to default values.
To Configure SunVTS for a Test Session

1. Identify the current state of SunVTS in the Status panel (FIGURE 5-2).
2. Specify the display mode, logical or physical, from the System View buttons:

![System View Buttons](image)

**FIGURE 5-3** OPEN LOOK System View Buttons

*About display modes:*

The devices that SunVTS identified as testable devices on your system are listed in the Test Selector panel.

You control the way that SunVTS displays these devices by selecting one of the following:

- **Logical Mapping**—organizes the devices, according to their function, into groups. For example, SCSI disk, SCSI tape, and SCSI CD-ROM drives are placed in the SCSI-Devices group. You can focus your testing on a specific device, device group, or on all of the groups on the system.

- **Physical Mapping**—shows the exact location of each device on the system in relation to how the devices are connected to each other. If you are testing a single-board type system, each device is shown under the system board. Multi-board type systems show each device under the board (for example, board0, board1, and so on) to which the device is attached. For example, if you have multiple disk drives connected to different disk interfaces, each disk would be displayed under the respective interface. From Physical Mapping, you can determine the actual location of each device. When possible, the board number and controller type for the device are also displayed.

3. **Select a test mode and Test Set from the Select Tests dialog box** *(FIGURE 5-4).*
FIGURE 5-4  OPEN LOOK Select Tests Dialog Box

About Test modes:
- Connection test mode—provides a low-stress, quick testing of the availability and connectivity of selected devices. These tests are non-intrusive, meaning they will release the devices after a quick test and they will not place a heavy load on system activity.
- Functional test mode—provides more robust testing of your system and devices. It will use your system resources for thorough testing and it assumes that no other applications are running.

About Test Set:
Depending on the devices on your system and the test mode that you select, SunVTS selects certain devices by default. You can use the Test Set choices to change the selected devices as follows:
- Default—selects the SunVTS default selected devices
- None—deselects all devices
- All—selects all devices
- Intervention—required before you can select tests that require special device preparation

Note – Any device that requires your intervention before the test can run (such as loading media for tape, CD-ROM, and diskette tests) also requires that you notify SunVTS that you have performed this action by selecting the Intervention button. You cannot select any intervention mode tests until you select this button.

How to do it:

a. Click on Select Tests in the Control panel.

b. Select either Connection test or Functional test from the Select Mode menu button.

c. Click OK in the confirmation window.

d. (Optional) Select the Test set: Default, None, or All
**Note** – You can refine your choice of selected devices later.

e. Select Intervention mode after preparing your devices.

f. Close the Select Tests dialog box (Alt-F4).

4. **Select the devices that you want to test.**

   **About selecting devices:**
   
   A checkmark next to a device in the Test Selector panel indicates that the device is selected for testing.
   
   **How to do it**:
   
   a. Click on the checkmark box to toggle the selection of devices (and device-groups) for testing.
   
   As you change your selections, the devices that are selected are added or subtracted from the list in the Test Status panel.

5. **Modify the system-level test options (if desired).**

   ![Set Options Menu](FIGURE 5-5 OPEN LOOK Set Options Menu)

   **About test options**:
   
   SunVTS is ready to test each device once you select it. You can, however, modify test options that alter the way tests run to suit your testing needs. There are three levels where you control test options:
   
   - **System-level options**—control the testing attributes of all devices. This is the highest level, applying all your options globally. When you modify option values at this level, the settings are propagated down to the group-level and device-level options.
   
   - **Group-level options**—control the testing attributes of all the devices in the group.
Device-level options—control the testing of a single, specific device.

The order that you apply the system-level, group-level, and device-level settings is important. Start by assigning the system-level settings, then assign the group-level settings, and finish with the device-level settings. Otherwise, if you make lower-level settings, then higher-level settings, the higher-level settings will propagate down and undo your lower-level settings. An alternative to this approach is to use locks and overrides to protect lower-level settings (see “Preserving Test Options with Locks and Overrides” on page 5-15).

How to do it:

a. Select one of the following from the Set Options pull-down menu:

- Thresholds
- Notify
- Schedule
- Test Execution
- Advanced

*Note* – See “SunVTS Dialog Boxes” on page A-9 for a description of these option dialog boxes.

b. Modify the options in the dialog box.

c. Close the dialog box.

6. Modify group-level and device-level options (if desired).

![FIGURE 5-6 OPEN LOOK Device Options Menu](image)

*About group and device specific options:*

Group-level and device-level options are testing attributes that accompany each test and pertain to a specific device (or device group) only. You have access to the following dialog boxes:
Test Options—shows device configuration information and provides the controls for defining specific test options. This menu is different for each type of test. Refer to the SunVTS 4.4 Test Reference Manual for descriptions.

Test Execution Options—allows you to define how a test runs. For example, you can select stress mode which enables the most rigorous testing. You can set the Max errors value to define the maximum number of allowable errors before stopping the test (0=continue to run on infinite errors).

Test Advanced Options—Provides a setting to “lock” the option settings for an individual device so that the system level setting will not affect the option setting for this test. See “Preserving Test Options with Locks and Overrides” on page 5-15 for more details.

Schedule Options (group level only)—sets the maximum number of tests you want to run at the same time in the same group.

How to do it:

a. Click on the device (or device group) in the Test Selector panel.

b. Select one of the dialog boxes.

c. Modify the options and close the dialog box.

To Run, Monitor, and Stop a Test Session

1. Start the test session by selecting Start from the Start pull-down menu.

   Depending on how you configured the settings in the Test Execution menus, testing will continue until:

   ■ a test error is detected (this is the default behavior). If you enter a value for Run On Error, SunVTS continues to run until the specified number of errors is reached.

   ■ testing has reached the Max Passes value. The default is to run indefinite test passes.

   ■ testing has reached the Max Time value. The default is to run indefinitely.

   ■ you stop the test session by clicking the Stop button.

2. Monitor the overall test session status by watching the Status panel.

   The total number of system passes, Total errors, and elapsed time is displayed.
3. **Monitor specific tests by watching the Test Status panel.**

   Watch for:
   - An asterisk—displayed next to each device indicating which device is currently under test. Depending on how you configured SunVTS (with the System Concurrency option), single or multiple devices are tested concurrently.
   - Test passes and errors for each device.

   You can use the Test Status arrow buttons to control the Test Status panel display as shown in FIGURE 5-7.

4. **Check for test messages by watching the Message panel.**

   The Message panel displays test messages under the following circumstances:
   - When a test error occurs.
   - If you enable trace mode and direct the trace messages to display in the window.
   - If you enable verbose mode (through the Test Execution dialog box), verbose messages are displayed.

5. **Stop the test session (if necessary).**

   If you want to stop the test session, click the Stop button.
To Review and Reset Test Session Results

1. Review the logs.

   About logs:
   SunVTS OPEN LOOK UI provides access to three log files:
   - SunVTS test error log—contains time-stamped SunVTS test error messages. The log file pathname is /var/opt/SUNWvts/logs/sunvts.err. This file is not created until a SunVTS test failure occurs.
   - SunVTS information log—contains informative messages that are generated when you start and stop SunVTS test sessions. The log file pathname is /var/opt/SUNWvts/logs/sunvts.info. This file is not created until a SunVTS test session runs.
   - Solaris system message log—is a log of all the general Solaris events logged by syslogd. The pathname of this log file is /var/adm/messages.

   How to do it:
   a. Click on Log Files in the Control panel.
      The Log files dialog box is displayed.
   b. Specify the log file that you want to view by selecting it from the Log Files dialog box.
   c. Select one of the three lower buttons:
      - Display—opens a window to display the log file.
      - Remove—deletes the specified log file.
      - Print—prints the contents of the specified log file to the printer specified in the Log Files dialog box.

   Note – Take the length of the log file into consideration before you print it.

2. Interpret SunVTS messages

   About messages:
   There are many messages for each of the many tests that run under SunVTS. For this reason, it is difficult to document the implication of each message that you might see. Most messages contain all the explanatory text that is possible for each event that is encountered. Some messages are information messages (INFO, VERBOSE,
WARNING) which do not represent an error, and some messages are error messages (ERROR and FATAL), indicating that the test detected a failure. This section explains generic test message information.

SunVTS information message example:

```
04/24/00 17:19:47 systemA SunVTS4.4: VTSID 34 disktest.VERBOSE
c0t0d0: "number of blocks 3629760"
```

SunVTS error message example:

```
05/02/00 10:49:43 systemA SunVTS4.4: VTSID 8040 disktest.
FATAL diskette: "Failed get_volmgr_name()"
Probable_Cause(s):
(1)No floppy disk in drive
Recommended_Action(s):
(1)Check the floppy drive
```

Whenever possible, the error message supplies a message type (TABLE 5-1), followed by the message text, one or more probable causes, and one or more recommended corrective actions.

The following table describes the types of messages you might encounter. All messages are displayed in the Message panel, and most are logged in one of the SunVTS logs (Info or Error).

**TABLE 5-1 Message Types**

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Log File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td>Info log</td>
<td>Displayed when a non-error test event occurs.</td>
</tr>
<tr>
<td>ERROR</td>
<td>Error and Info logs</td>
<td>Displayed when a test detects an error, often an indication of a problem with a specific function or feature of the device under test.</td>
</tr>
<tr>
<td>FATAL</td>
<td>Error and Info logs</td>
<td>Displayed when a test detects a severe error that might cause the test to exit, such as a failure to open a device. These errors are indicative of hardware failures.</td>
</tr>
<tr>
<td>VERBOSE</td>
<td>Not logged</td>
<td>Test progression messages that are displayed when the verbose feature is enabled.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Info log</td>
<td>Displayed when something affects the test that is not an error, such as a device that is busy.</td>
</tr>
</tbody>
</table>

You can write scripts that watch for certain SunVTS events as they are logged in the log files, and which trigger an action when a particular message string occurs. If you
plan to do this, refer to the following SunVTS message syntax and descriptions in Chapter 4, TABLE 4-2.

**Note** – The message syntax changed as of SunVTS 4.0. For the old message syntax information, see “Frequently Asked Questions” on page B-1. In a future version of SunVTS, the old message format will no longer be supported. Update any scripts that rely on the old message format.

3. Reset the test session results (if desired) by clicking the Reset button in the Control panel.
   The previous test session information is cleared from the main window. This does not reset your test options.

### 5.2 Using Additional Features with the SunVTS OPEN LOOK UI

The following features are described:
- “Connecting to Another Host” on page 5-12
- “Controlling the Size of the Log Files” on page 5-13
- “Tracing a Test” on page 5-14
- “Preserving Test Options with Locks and Overrides” on page 5-15
- “Scaling Your Test Session” on page 5-16
- “Using the Debugging Features” on page 5-18
- “Saving a Test Session Configuration for Repeated Use (Option Files)” on page 5-18
- “Using the Auto-Start Feature” on page 5-20
- “Suspending and Resuming a Test Session” on page 5-20
- “Recording and Replaying a Test Session” on page 5-21

#### 5.2.1 Connecting to Another Host

You can connect the SunVTS user interface on your local system to a SunVTS kernel that is running on another system in your network. Once you are connected to the remote system, all of the controls in the UI control the testing of the remote system.
To Connect to Another Host

1. **Make sure that the SunVTS kernel is running on the remote system.**
   You can do this in several ways. See “To Start the SunVTS Kernel (vtsk)” on page 3-7.

2. **On the local system (the system running the SunVTS UI), Click the “Connect to” button.**
   The Connect to Machine dialog box is displayed.

3. **Specify the name of the remote system to which you want to connect.**

4. **Click Apply.**
   The SunVTS UI now controls the testing of the remote system.

Using the Email Notification Feature

You can have SunVTS send the test status messages to you using email.

1. **Select Notify from the Set Options pull-down menu.**
   The Notify Options dialog box is displayed.

2. **Select one of the following from the Send Email pull-down menu:**
   - **Disabled**—disables the email notification feature.
   - **Now**—send email immediately one time, then disable the notification feature.
   - **On Error**—send email when an error occurs.
   - **Periodically**—send email at regular intervals as specified in the Log Period.
   - **on_error&periodically**—send email periodically and when an error occurs.

3. **Enter an email address in the email address field.**

4. **If you selected Periodically or on_error&periodically, specify the log period in minutes.**

5. **Click Apply.**

5.2.2 Controlling the Size of the Log Files

The log file sizes of the SunVTS test error log (/var/opt/SUNWvts/logs/sunvts.err), the SunVTS kernel error log (/var/opt/SUNWvts/logs/vtsk.err), and the information log (/var/opt/SUNWvts/logs/sunvts.info) are each limited to a maximum size of 1 Mbyte by default. When the log file reaches the maximum size, the content is moved to a file called logfilename.backup.
Additional events are added to the main log files. If the log file reaches the maximum size again, the content is moved to the backup file, overwriting the earlier backup file content. Only one backup file is maintained for each log file.

▼ To Modify the Log File Size Limits

1. Select Thresholds from Set Options in the Control panel.
   The Thresholds Option dialog box is displayed.

2. Use the arrows to increase the Max System Log Size number.
   Select a number from 1 to 5 (Mbytes). For example, if you choose 5 Mbytes, SunVTS will use up to 30 Mbytes for log files (there are three log files, each with an equal size backup file).

3. Click Apply.

5.2.3 Tracing a Test

Use the Trace test option to create a log of every system call made when a test is running. This feature logs the system calls using the standard UNIX command `truss`. The trace messages logged by this feature give you a powerful debugging tool when isolating the specific cause of an error.

▼ To Enable Tracing

1. Click the Trace Test button.
   The Trace Test dialog box is displayed.

2. Choose the tests to trace from the list of test names.
   When you select a test, system call tracing is enabled immediately. If the test is already running when you select it, tracing begins immediately and the trace test messages appear in the SunVTS console window. A “T” is displayed next to each trace-enabled device.

   **Note** – The trace feature places additional processing overhead on the test. If you trace more than one test, the additional overhead can degrade performance. If you send the trace messages to a file, the file size increases rapidly.
3. Select one of the following:
   - Console—displays trace messages in the Message panel.
   - File—records trace messages in /var/opt/SUNWvts/logs/sunvts.trace.

4. Click Done.

▼ To Disable Tracing

1. Bring up the Trace Test window again, click on Disable All.
   The trace mode is disabled.

2. Click Done.

5.2.4 Preserving Test Options with Locks and Overrides

With locks and overrides you can preserve or override the options you set at the system level, group level, and device level.

5.2.4.1 Locks

Normally, when you change an option setting at the system level or group level, the new option setting propagates down to all lower levels. Enabling the lock prevents an option setting made at a higher level from affecting the lower-level option setting.

Note – Overrides nullify lower-level locks.

▼ To Set (or Unset) a Lock

1. Open the Test Advanced Options dialog box from the group level or device level you want to lock.

2. Click on the Enable button to set the lock (or Disable button to unset the lock).
   With the lock set, you can make option setting changes at higher levels without affecting the option settings of the locked device (or device-group).
3. Click Apply.

5.2.4.2 Overrides

You can use overrides to void the lock protection. Setting the system-level override nullifies all locks, and setting a group-level override nullifies all the locks below that group.

▼ To Set (or Unset) an Override

1. Open the Advanced Option dialog box at one of the following levels:
   - System level—select Advanced from the Set Options in the Control panel.
   - Group level—place your pointer over the group and select Test Advanced Options.

2. Enable the Override setting (or disable the Override setting to unset it).

3. Click Apply.

5.2.5 Scaling Your Test Session

You can use a combination of options to scale testing intensity to meet your diagnostic needs. For example, you can modify test options so that each test instance runs simultaneously, thus increasing the stress level for a single or multiprocessor system. The following procedures can be used individually, or in combination to scale the test session.

▼ To Modify the Number of Test Instances

You can scale your test session by running multiple copies of the same test on your devices. Each copy is called a test instance. Each test instance is a separate process of the same test. The number of test instances can be set at the system level, group level, and the device level as follows:

1. Open the Test Execution dialog box at one of the following levels:
   - System level—select Test Execution from Set Options in the Control panel.
   - Group level—place your pointer over the group and select Test Execution Options from the pull-down menu.
   - Device level—place your pointer over the device and select Test Execution Options from the pull-down menu.

2. Use the arrow buttons to increase or decrease the number of instances.
3. Click Apply.

▼ To Modify Test Concurrency Options

The test concurrency option sets the number of tests that run at a given time during a test session. You can set this value to one to run one test at a time, or increase the test concurrency value thus increasing the stress level of your test session.

There are two settings you can make in the Schedule Option dialog boxes (at the system level and group level) to scale your test session:

■ System Concurrency—sets the maximum number of tests that run simultaneously at the system level. It overrides the Group Concurrency option.

■ Group Concurrency—sets the maximum number of tests that run at the simultaneously in the same group. This option is available at the system level and the group level.

1. Open the Test Execution dialog box from one of the following levels:
   ■ System level—select Test Execution from Set Options in the Control panel.
   ■ Group level—place your pointer over the group and select Test Execution Options from the pull-down menu.

2. Use the arrow buttons to increase or decrease the System Concurrency and Group Concurrency values.

3. Click Apply.

▼ To Bind a Test to a Processor with the Processor Affinity Option (for Multiprocessor Systems)

By default, the Solaris kernel assigns each test instance to whichever processor is available at the time. On multiprocessor systems, you can bind (assign) a test instance to a particular processor as follows:

1. Open the Test Execution dialog box at one of the following levels:
   ■ System level—select Test Execution from Set Options in the Control panel.
   ■ Group level—place your pointer over the group and select Test Execution Options from the pull-down menu.
   ■ Device level—place your pointer over the device and select Test Execution Options from the pull-down menu.

Note — The Processor Affinity field is only displayed on multiprocessor systems.
Note – The Processor Affinity option is not available for processor tests such as cputest and fputest. These tests are associated with each individual processor on your system and you cannot bind these tests to a different processor.

2. Select a Processor from the Processor Affinity field.

3. Click Apply.

5.2.6 Using the Debugging Features

You can enable certain options that cause the SunVTS test session to output more test data than when you run the session with the default option values. The following procedures describe how to enable these features.

▼ To Enable (or Disable) Debugging Options

1. Open the Test Execution dialog box at one of the following levels:
   - System level—select Test Execution from Set Options in the Control panel.
   - Group level—place your pointer over the group and select Test Execution Options from the pull-down menu.
   - Device level—place your pointer over the device and select Test Execution Options from the pull-down menu.

2. Enable (or disable) one or more of the following options:
   - Verbose—displays verbose messages indicating when the test is starting and stopping during the test session.
   - Core File—when enabled, creates a core file when a test session results in a core dump. The core file is called sunvts_install_dir/bin/core.testname.xxxxxx, where testname is the test that dumped the core, and xxxxxx is a character string generated by the system in order to make the file name unique.

5.2.7 Saving a Test Session Configuration for Repeated Use (Option Files)

You can use the Option Files feature to save the current set of selected devices and test options for reuse. This is a convenient feature when you plan to use the same test session configuration over and over again.

The configuration information is saved in a filename of your choice in the /var/opt/SUNWvts/options directory.
Note – Do not manually edit any option file. Unnecessary or spurious characters in the option file can cause unexpected behavior when you use it.

▼ To Create an Option File

1. **Configure SunVTS for the test session that you want to save.**
   
   See “To Configure SunVTS for a Test Session” on page 5-3.

2. **Click Option Files in the Control panel.**
   
   The Option Files dialog box is displayed.

3. **Specify an option file name in the Option File Name field.**

4. **Click on Store.**
   
   The Option Files dialog box is closed, and your test session configuration is saved for future use.

▼ To Load an Option File

Note – Loading an option file that was created on another system is permitted, but you must make sure that the configuration is valid for the system you plan to test.

Note – Do not load an option file that was created in a 64-bit environment into a 32-bit environment.

1. **Select Option Files from the Control panel.**
   
   The Options Files dialog box is displayed.

2. **Select an option file from the Option File pull-down list.**

3. **Click Load.**
   
   The test session configuration is loaded into SunVTS. You can use this configuration, or modify it before you start the test session.

▼ To Remove an Option File

1. **Select Option Files from the Control panel.**
   
   The Options Files dialog box is displayed.

2. **Select the option file that you want to delete from the Option File pull-down list.**
3. Click Remove.
4. Click OK in the confirmation dialog box.

5.2.8 Using the Auto-Start Feature

You can use the auto-start feature, along with saved option files, to simplify the process of configuring a test session and running it.

▼ To Configure SunVTS to use the Auto-Start Feature

1. Select Schedule from Set Options in the Control panel.
   The Schedule dialog box is displayed.
2. Enable the Auto Start setting in the Schedule dialog box.
   SunVTS is configured to automatically start testing.
3. Create an option file.
   See “To Create an Option File” on page 5-19.

▼ To Use the Auto-Start Feature

1. Select Terminate UI & Kernel from Quit in the Control panel.
   You must quit SunVTS and restart it for the auto-start feature to work.
2. Use the following command to restart SunVTS from the command-line, specifying the Option File that you created:

   ```
   # /opt/SUNWvts/bin/sunvts -ol option_file
   ```
   SunVTS displays the main window and automatically starts the test session.

5.2.9 Suspending and Resuming a Test Session

You can suspend a test session while it is running. For example, you might want to look at messages on the Console panel that have scrolled out of view, or you may want to view and print a log file.
To Suspend and Resume a Test Session

1. **While the test session is running**, click Suspend in the Control panel.
   “Suspended” is displayed in the status panel, and the test session pauses until you resume it.

2. **Click Resume in the Control panel.**
   “Testing” is displayed in the Status panel, and the SunVTS kernel resumes the suspended test session.

### 5.2.10 Recording and Replaying a Test Session

You can use the Record and Replay feature to record a SunVTS test session. Only one test session recording is saved at a time.

The events are recorded in a file called `/var/opt/SUNWvts/vts_replay_file`

Once a test session is recorded, you can use the recorded events to drive the SunVTS kernel so it reproduces the recorded sequence of events at a later time.

**Note** – The Record and Replay feature closely reproduces the sequence of events, but it cannot reproduce the time periods of these events because the execution times vary from one run to another.

To Record and Replay a Test Session

1. **Configure SunVTS for the test session that you want to run.**
   See To Configure SunVTS for a Test Session on page 3.

2. **Select Start With Record from Start in the Control panel.**
   The test session runs, and the events are recorded. When testing stops, the recorded session is available to replay.

3. **Select Replay from Start in the Control panel.**
   The kernel reruns the same tests, with the same configuration that you specified in when you configured SunVTS.

**Note** – During the replay, the kernel is actually rerunning the tests, not just re-displaying the recorded session.
This chapter describes how to run a test session using the SunVTS TTY UI. The procedures are written in a step-by-step form so you can use them to become familiar with SunVTS using the SunVTS TTY UI. This chapter is divided into the following sections:

- “Getting Started with the SunVTS TTY UI” on page 6-1
- “Using Additional Features with the SunVTS TTY UI” on page 6-16

Note – This chapter assumes that you have already performed the following procedures:
- Installed SunVTS as described in Chapter 2 “Installing and Removing SunVTS”
- Started SunVTS as described in Chapter 3 “Starting SunVTS”
- Prepared your system for testing as described in Section 3.4 “Preparing Devices for Testing”

See Appendix A “SunVTS Window and Dialog Box Reference” for descriptions of each SunVTS window and dialog box.

6.1 Getting Started with the SunVTS TTY UI

This section describes how to use the fundamental features of the SunVTS TTY UI to perform diagnostic testing on a system. For information about using more advanced features, see “Using Additional Features with the SunVTS TTY UI” on page 6-16.
6.1.1 The SunVTS TTY UI Main Window and Keyboard Commands

The SunVTS TTY UI is an ASCII based, screen-oriented interface that does not require a graphical window environment. Most of the control and monitoring options that are available in the SunVTS graphical interfaces are also available in the TTY interface.

You can use the TTY interface to run SunVTS from a serial terminal, or through a graphical window tool such as a shell tool, command tool, or CDE terminal window.

The procedures in this chapter explain how to use the TTY main window:

- “To Configure SunVTS for a Test Session” on page 6-4
- “To Run, Monitor, and Stop a Test Session” on page 6-12
- “To Review and Reset Test Session Results” on page 6-13
FIGURE 6-1  SunVTS TTY Main Window

TABLE 6-1  SunVTS TTY Main Window

<table>
<thead>
<tr>
<th>Window Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control panel</td>
<td>Provides access to SunVTS controls.</td>
</tr>
<tr>
<td>Test_Groups panel</td>
<td>Shows the testable devices (categorized in groups) and provides access to their test options.</td>
</tr>
<tr>
<td>Status panel</td>
<td>Displays SunVTS test status information.</td>
</tr>
<tr>
<td>Message console</td>
<td>The area where test messages are displayed. No user input is accepted in this panel. You can use up and down arrow keys to scroll through the messages in this panel.</td>
</tr>
</tbody>
</table>
Navigating the SunVTS TTY UI

Use keyboard commands instead of mouse and pointer action to control SunVTS in the TTY UI. The following table lists the keyboard commands and explains how to use them.

**TABLE 6-2**  TTY Keyboard Commands

<table>
<thead>
<tr>
<th>Key</th>
<th>Description of Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Moves you from one panel to another. For example, if you are working in the Control panel and press the Tab key, the focus (or highlight) shifts to the Status panel. Highlighted panels are bordered by asterisks (*).</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Moves between selections within a panel</td>
</tr>
<tr>
<td>Return</td>
<td>• Displays a menu&lt;br&gt;• Selects and applies a choice or a command in a menu</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Selects or deselects a checkbox:&lt;br&gt;• [ * ] = selected&lt;br&gt;• [ ] = deselected</td>
</tr>
<tr>
<td>Backspace key</td>
<td>Deletes text in a text field</td>
</tr>
<tr>
<td>Escape</td>
<td>Discards a pop-up menu or window</td>
</tr>
<tr>
<td>Control-F</td>
<td>Scrolls forward in a scrollable window</td>
</tr>
<tr>
<td>Control-B</td>
<td>Scrolls backward in a scrollable window</td>
</tr>
<tr>
<td>Control-X</td>
<td>Quits the TTY user interface but leaves the SunVTS kernel running</td>
</tr>
<tr>
<td>Control-L</td>
<td>Refreshes the TTY window</td>
</tr>
</tbody>
</table>

▼ To Configure SunVTS for a Test Session

1. Identify the current state of SunVTS in the Status panel.
Chapter 6 Using the SunVTS TTY User Interface

6-5

Figure 6-2 Status panel (TTY)

- **System_status**—provides the following status of SunVTS:
  - **Idle**—no testing is taking place
  - **Testing**—a test session is running
  - **Suspend**—a test session is suspended
  - **Replay**—a previously recorded test session is displayed
  - **Stopping**—is momentarily displayed when a test session stops

- **System_passes**—displays the total number of successful system passes (a system pass is when all tests have run once).
- **Total_errors**—the total number of errors from all tests.
- **Elapsed_time**—indicates the total number of hours, minutes, and seconds that elapsed during testing.
- **List of devices to test with pass and error counts.**

2. **Select a test mode (Functional or Connection).**
   
   **About Test modes:**
   
   - Connection test mode—provides a low-stress, quick testing of the availability and connectivity of selected devices. These tests are non-intrusive, meaning they will release the devices after a quick test and they will not place a heavy load on system activity.
- Functional test mode—provides more robust testing of your system and devices. It will use your system resources for thorough testing and it assumes that no other applications are running.

How to do it:

a. Use the tab key to move to the Control panel (if needed).

b. Use the arrow keys to highlight test_mode and press return.

The test_mode menu is displayed.

c. Use the arrow keys to highlight functional or connectivity and press return.

d. Use the arrow key to highlight OK in the confirmation dialog box and press return.

Note — You can exit any menu, at any time with the <Esc> key.

3. Specify the display mode (logical or physical).

About display modes:

- Logical Mapping—organizes the devices, according to their function, into groups. For example, SCSI disk, SCSI tape, and SCSI CD-ROM drives are placed in the SCSI-Devices group. You can focus your testing on a specific device, device group, or on all of the groups on the system.

- Physical Mapping—shows the exact location of each device on the system in relation to how the devices are connected to each other. If you are testing a single-board type system, each device is shown under the system board. Multi-board type systems show each device under the board (for example, board0, board1, and so on) to which the device is attached. For example, if you have multiple disk drives connected to different disk interfaces, each disk would be displayed under the respective interface. From Physical Mapping, you can determine the actual location of each device. When possible, the board number and controller type for the device are also displayed.

How to do it:
a. Use the arrow keys to highlight grouping and press return.

The grouping menu is displayed.

b. Use the arrow keys to highlight logical or physical and press return.

4. Enable Intervention mode (if needed).

About Intervention mode:

Any device that requires your intervention before the test can run (such as loading media for tape, CD-ROM, and diskette tests) also requires that you notify SunVTS that you have performed this action by enabling Intervention mode. You cannot select any intervention mode devices until you enable this mode.

How to do it:

a. Prepare the device for testing (see “Preparing Devices for Testing” on page 3-4).

b. Use the tab key to move to the Control panel.

c. Use the arrow keys to highlight intervention and press return.

d. Use the arrow keys to highlight Enable and press return.

5. Select the device groups that you want to test.

About device groups:

An asterisk next to a device group in the Test_Groups panel indicates that the devices in that group are selected. Depending on the devices on your system, and the test mode that you select, SunVTS selects certain devices by default. You can change the selected devices.

How to do it:

a. Use the tab key to move to the Control panel.

b. Use the arrow keys to highlight test_select and press return.

c. Use the arrow keys to highlight one of the following:

- Default—selects the SunVTS default selected devices
- None—deselects all devices
- All—selects all devices
6. Select specific devices to test.
   
   About specific devices:
   
   In the previous step, you selected sets of devices for testing by choosing device groups. You can further refine your device selection by selecting or deselecting specific devices.
   
   How to do it:
   
   a. Use the tab key to move to the Test_Groups panel.
   
   b. Use the arrow keys to highlight the device group for which you plan to select or deselect individual devices, and press return.
      
      The individual devices within that group are displayed in a list.
      
      ![List of devices](FIGURE_6-5)
      
      FIGURE 6-5 Devices within a Group (TTY)
   
   c. Use the arrow keys to highlight the [ ] (brackets) next to the device that you want to select or deselect.
   
   d. Press the space-bar to toggle the asterisk.
   
   e. Press return to close the group.
      
      Notice that the Status panel displays (or removes) the devices as you select (or deselect) them.
7. **Modify the system-level test options (if desired).**

*About test options:*

SunVTS is ready to test each device once you select it. You can, however, modify test options that alter the way tests run to suit your testing needs. There are three levels where you control test options:

- **System-level options**—control the testing attributes of all devices. This is the highest level, applying all your options globally. When you modify option values at this level, the option settings are propagated down to the group level and device level options.

- **Group-level options**—control the testing attributes of all the devices in the group. Settings made at this level propagate down, setting all the options in the group.

- **Device-level options**—control the testing of a single, specific device.

The order that you apply the system-level, group-level, and device-level options is important. Start by assigning the system-level options, then assign the group-level options, and finish with the device-level options. Otherwise, if you make lower-level options, then higher-level options, the higher-level options will propagate down and undo your lower-level options. An alternative to this approach is to use locks and overrides to protect lower-level options. See “Preserving Test Options with Locks and Overrides” on page 6-18.

*How to do it:*

a. Tab to the Control panel.

b. **Use the arrow keys to highlight set_options and press return.**

   The set_options menu is displayed.

   ![FIGURE 6-6 set_options Menu (TTY)](image)

   c. **Use the arrow keys to select one of the following menus, and press return:**

   - Thresholds
   - Notify
   - Schedule
   - Test_execution
   - Advanced

   "[DONE;ESC]****"
d. Use the arrow keys and numeric keys to set the options values.

e. Use the arrow keys to highlight `Apply` and press return.

8. Modify group-level and device-level options (if desired).

About group-level and device-level options:

Group-level and device-level options are similar to the system-level testing attributes, but instead pertain to a specific device (or device group) only. You modify these options by changing values in the following dialog boxes:

- `Test_Parameters`
- `Test_Execution`
- `Advanced`
- `Schedule` (group-level only)

How to do it:

a. Tab to the `Test_Groups` panel.

b. Use the arrow keys to highlight the device group and press return.

   At this point you can choose to access the group-level option menu instead by highlighting `Option` (instead of the device-level) and press return. Then go to Step d. Otherwise, the following steps will direct you to modify device-level options.

c. Use the arrow keys to select a device from the device list and press return.

   The `Test_Options` menu is displayed.
d. Select one of the option dialog boxes (Test_Parameters, Test_Execution, or Advanced) and press return.

Note – For descriptions of these menus, see “SunVTS Dialog Boxes” on page A-9.

e. Use the arrow and numeric keys to modify the options in the dialog box.

f. Use the arrow keys to highlight apply and press return.

If you selected the Test_Parameters dialog box, you will be prompted to apply your changes to one of the following:

- **Within_Instance**—applies the option settings to this test instance (test instance 1 for example) for this device with Apply, or to all the same instances within the same device-group with Apply_to_group, or to all the same instances for all like devices with Apply_to_all.

- **Across_All_Instances**—applies the option settings to all test instances (for example, instance 1 and 2) to this device with Apply, or to all the instances for all the devices in the group with Apply_to_group, or to all the instances for all like devices with Apply_to_all.
To Run, Monitor, and Stop a Test Session

1. Start the test session.
   
   How to do it:

   a. Use the tab key to move to the Control panel.

   b. Use the arrow keys to highlight start and press return.
      The start menu is displayed.

   c. With start highlighted (the default) press return.
      The test session begins.

      Depending on how you configured the options in the Test_Execution menus, testing will continue until:

      ■ a test error is detected (this is the default behavior). If you enter a value for
        Run_On_Error, SunVTS continues to run until the specified number of errors is
        reached.

      ■ testing has reached the Max_Passes value. The default is to run indefinite test
        passes.

      ■ testing has reached the Max_Time value. The default is to run indefinitely.

      ■ you select Stop in the Control panel.

2. Monitor the overall test session status by watching the Status panel.
   
   The Status panel indicates that a test session is running by displaying testing for the
   System_status. The System_passes, Total_errors, and elapsed_time will
   increment.

3. Monitor specific tests by watching the Status panel.
   
   Watch for:
■ An asterisk—displayed next to each device indicating which device is currently under test. Depending on how you configured SunVTS (with the System Concurrency option), single or multiple devices are tested concurrently.
■ Pass and Error columns—Indicates the state of each device test.

4. Check for test messages by watching the Message console panel.
   The Message console panel displays test messages under the following circumstances:
   ■ When a test error occurs
   ■ If you enable trace mode
   ■ If you enable verbose mode
   Use the up and down arrow keys to scroll through messages in this panel.

5. Stop the test session (if desired).
   How to do it:
   a. Use the tab key to move to the Control panel.
   b. If stop is not highlighted, use the arrow keys to highlight it, and press return.
      The test session displays a confirmation menu.
   c. Press <Esc> to dismiss the confirmation menu.
      The test session stops.

▼ To Review and Reset Test Session Results

1. Review the logs.
   About logs:
   SunVTS provides access to four log files:
   ■ SunVTS test error log—contains time-stamped SunVTS test error messages. The log file pathname is /var/opt/SUNWvts/logs/sunvts.err. This file is not created until a SunVTS test failure occurs.
   ■ SunVTS kernel error log—contains time-stamped SunVTS kernel and SunVTS probe errors. SunVTS kernel errors are errors that relate to running SunVTS, and not to testing of devices. The log file pathname is /var/opt/SUNWvts/logs/vtsk.err. This file is not created until SunVTS reports a SunVTS kernel error.
   ■ SunVTS information log—contains informative messages that are generated when you start and stop SunVTS test sessions. The log file pathname is /var/opt/SUNWvts/logs/sunvts.info. This file is not created until a SunVTS test session runs.
   ■ Solaris system message log—is a log of all the general Solaris events logged by syslogd. The pathname of this log file is /var/adm/messages.
How to do it:

a. Use the tab keys to move to the Control panel.

b. Use the arrow keys to highlight log_files.

   The log_files menu is displayed.

c. Use the arrow keys to select one of the three log files and press return.

d. Use the arrow keys to select one of the following:
   ■ Display—the content of the log file is displayed.
   ■ Remove—the content of the log file is deleted.
   ■ Print—the print menu is displayed. Specify the name of the printer in this menu, highlight Apply, and press return. The content of the log file is sent to the printer.

   Note – SunVTS uses your default editor to display the log file. In many cases, the default editor is vi and you can use the standard vi commands to view the content. However, the file is opened in read-only mode, so you cannot do anything to alter the content. Use the vi command :q to quit and return to the main TTY window.

   ■ Print—the print menu is displayed. Specify the name of the printer in this menu, highlight Apply, and press return. The content of the log file is sent to the printer.

   Note – Take the length of the log file into consideration before you print it.

e. Press <Esc> to close the log_file menu.

2. Interpret SunVTS messages

   There are many messages for each of the many tests that run under SunVTS. For this reason, it is difficult to document the implication of each message that you might see. Most messages contain all the explanatory text that is possible for each event that is encountered. Some messages are information messages (INFO, VERBOSE,
WARNING) which do not represent an error, while some messages are error messages (ERROR and FATAL), indicating that the test detected a failure. This section explains generic test message information.

SunVTS information message example:

```
04/24/00 17:19:47 systemA SunVTS4.4: VTSID 34 disktest.VERBOSE
c0t0d0: "number of blocks 3629760"
```

SunVTS error message example:

```
05/02/00 10:49:43 systemA SunVTS4.4: VTSID 8040 disktest.
FATAL diskette: "Failed get_volmgr_name()"
Probable_Cause(s):
(1)No floppy disk in drive
Recommended_Action(s):
(1)Check the floppy drive
```

Whenever possible, the error message supplies a message type (TABLE 6-3), followed by the message text, one or more probable causes, and one or more recommended corrective actions.

The following table describes the types of messages you might encounter. All messages are displayed in the Message panel, and most are logged in one of the SunVTS logs (Info or Error).

**TABLE 6-3  Message Types**

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Log file</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFO</td>
<td>Info log</td>
<td>Displayed when a non-error test event occurs.</td>
</tr>
<tr>
<td>ERROR</td>
<td>Error and Info logs</td>
<td>Displayed when a test detects an error, often an indication of a problem with a specific function or feature of the device under test.</td>
</tr>
<tr>
<td>FATAL</td>
<td>Error and Info logs</td>
<td>Displayed when a test detects a severe error that might cause the test to exit, such as a failure to open a device. These errors are indicative of hardware failures.</td>
</tr>
<tr>
<td>VERBose</td>
<td>Not logged</td>
<td>Test progression messages that are displayed when the verbose feature is enabled.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Info log</td>
<td>Displayed when something affects the test that is not an error, such as a device that is busy.</td>
</tr>
</tbody>
</table>

You can write scripts that watch for certain SunVTS events as they are logged in the log files, and which trigger an action when a particular message string occurs. If you
3. Reset the test session results (if desired).

*How to do it:*

a. Use the tab key to move to the Control panel.

b. Use the arrow keys to highlight reset and press return.

The information in the Status panel is reset. This does not reset your test options.

---

**6.2 Using Additional Features with the SunVTS TTY UI**

This section describes additional SunVTS features using the SunVTS TTY user interface:

- “Connecting to Another Host” on page 6-17
- “Using the Email Notification Feature” on page 6-17
- “Controlling the Size of the Log Files” on page 6-18
- “Preserving Test Options with Locks and Overrides” on page 6-18
- “Scaling Your Test Session” on page 6-19
- “Using the Debugging Features” on page 6-21
- “Saving a Test Session Configuration for Repeated Use (Option Files)” on page 6-22
- “Using the Auto-Start Feature” on page 6-23
- “Suspending and Resuming a Test Session” on page 6-24
- “Recording and Replaying a Test Session” on page 6-25
6.2.1 Connecting to Another Host

You can connect the SunVTS user interface on your local system to a SunVTS kernel that is running on another system in your network. Once you are connected to the remote system, all of the controls in the TTY UI control the testing of the remote system.

▼ To Connect to Another Host

1. Make sure that the SunVTS kernel is running on the remote system.
   You can do this in several ways. You can remote login (using `rlogin` or `telnet`) to the remote system and run the `vtsk` command (see “To Start the SunVTS Kernel (`vtsk`)” on page 3-7) to start the kernel.

   **Note** – On the remote system, you must login (or switch user) as a user that has SunVTS privileges (superuser by default) before you can start the SunVTS kernel (`vtsk`).

2. Open the `Connect_to_Host` menu:
   a. In the Control panel, highlight `connect_to` and press return.
   b. Enter the remote system hostname in the `connect_to_host` field.
   c. Highlight `Apply` and press return.
   d. Press `<Esc>` when you receive the `connect_to` confirmation box.

   The SunVTS UI now controls SunVTS on the remote system. The remote system hostname is displayed at the top of the TTY main menu.

6.2.2 Using the Email Notification Feature

You can have SunVTS send test status messages to you using email.

▼ To Enable Email Notification

1. In the Control panel, highlight `set_options` and press return.
   The `set_options` menu is displayed.

2. Select `Notify` and press return.

3. Complete the notify menu items.

6.2.3 Controlling the Size of the Log Files

The log file sizes of the SunVTS test error log (/var/opt/SUNWvts/logs/sunvts.err), the SunVTS kernel error log (/var/opt/SUNWvts/logs/vtsk.err) and the information log (/var/opt/SUNWvts/logs/sunvts.info) are each limited to a maximum size of 1 Mbyte by default. When the log file reaches the maximum size, the content is moved to a file called logfilename.backup. Additional events are added to the main log files. If the log file reaches the maximum size again, the content is moved to the backup file, overwriting the earlier backup file content. Only one backup file is maintained for each log file.

You can modify the log file maximum size specification.

▼ To Modify the Log File Size Limits

1. In the Control panel, highlight set_options and press return.
   The set_options menu is displayed.
2. Highlight Thresholds in the set_options menu and press return.
3. Enter a value (1-5) in the Max System Log Size field.

6.2.4 Preserving Test Options with Locks and Overrides

With locks and overrides you can preserve or override the options you set at the system level, group level, and device level.

6.2.4.1 Locks

Normally, when you change an option setting at the system level or group level, the new option setting propagates down to all lower levels. Enabling the lock prevents an option setting made at a higher level from affecting the lower-level option setting.

Note – Overrides nullify lower-level locks.

▼ To Set (or Unset) a Lock

1. Open the Test Advanced Options dialog box from the group level or device level you want to lock as follows:
   a. Move to the Test_Groups panel.
Chapter 6 Using the SunVTS TTY User Interface

6.2.4.2 Overrides

You can use overrides to void the lock protection. Setting the system-level override nullifies all locks, and setting a group-level override nullifies all the locks below that group.

▼ To Set (or Unset) an Override

1. Open the Advanced Option dialog box at one of the following levels:
   - System-level—select Advanced from the set_options in the Control panel.
   - Group-level—select Advanced from Options next the to group in the Test_Groups panel.

2. Highlight the Override setting (enable/disable), and press return.
   The enable disable menu is displayed.

3. Select enable (or disable), and press return.

4. Highlight Apply, and press return.

6.2.5 Scaling Your Test Session

You can use a combination of options to scale testing intensity to meet your diagnostic needs. For example, you can modify test options so that each test instance runs simultaneously, thus increasing the stress level for a single or multiprocessor system. The following procedures can be used individually or in combination to scale the test session.
To Modify the Number of Test Instances

You can scale your test session by running multiple copies of the same test on your devices. Each copy is called a *test instance*. Each test instance is a separate process of the same test. The number of test instances can be set at the system level, group level, and the device level as follows:

1. **Open the Test_Execution Option menu at one of the following levels:**
   - System-level—select Test_Execution from the set_options menu in the Control panel.
   - Group-level—select Test_Execution from Options next to the group in the Test_Groups panel.
   - Device-level—select Test_Execution from the device in the device option menu.

2. **Highlight the Num of Instances setting, and enter the value you want.**

3. **Highlight Apply, and press return.**

To Modify Test Concurrency Options

The test concurrency option sets the number of tests that run at a given time during a test session. You can set this value to one to run one test at a time, or increase the test concurrency value thus increasing the stress level of your test session.

There are two options you can modify in the Schedule Option dialog boxes (at the system level and group level) to scale your test session:

- **System Concurrency**—sets the maximum number of tests that run simultaneously at the system level. It overrides the Group Concurrency option.
- **Group Concurrency**—sets the maximum number of tests that run simultaneously in the same group. This option is available at the system level and the group level.

1. **Open the Schedule Option menu at one of the following levels:**
   - System-level—select Schedule from the set_options menu in the Control panel.
   - Group-level—select Schedule from Options next to the group in the Test_Groups panel.

2. **Highlight the concurrency setting, and enter the value you want.**

3. **Highlight Apply, and press return.**
To Bind a Test to a Processor with the Processor Affinity Option (for Multiprocessor Systems)

By default, the Solaris kernel assigns each test instance to whichever processor is available at the time. On multiprocessor systems, you can bind (assign) a test instance to a particular processor as follows:

1. Open the Test_Execution Option menu at one of the following levels:
   - System-level—select Test_Execution from the set_options menu in the Control panel.
   - Group-level—select Test_Execution from Options next to the group in the Test_Groups panel.
   - Device-level—select Test_Execution from the device in the device option menu.

   Note – The Processor Affinity field is only displayed on multiprocessor systems.

   Note – The Processor Affinity option is not available for processor tests such as cputest and fputest. These tests are associated with each individual processor on your system and you cannot bind these tests to a different processor.

2. Highlight the Processor Affinity setting, and enter the value you want.
3. Highlight Apply, and press return.

6.2.6 Using the Debugging Features

You can enable certain options that cause the SunVTS test session to output more test data than when you run the session with the default option values. The following procedures describe how to enable these features.

To Enable (or Disable) Debugging Options

1. Open the Test_Execution Option menu at one of the following levels:
   - System-level—select Test_Execution from the set_options menu in the Control panel.
   - Group-level—select Test_Execution from Options next to the group in the Test_Groups panel.
   - Device-level—select Test_Execution from the device in the device option menu.
2. Enable (or disable) one or more of the following options:

- **Verbose**—displays verbose messages indicating when the test is starting and stopping during the test session.
- **Core File**—when enabled, creates a core file when a test session results in a core dump. The core file is called `sunvts_install_dir/bin/core.testname.xxxxx`, where `testname` is the test that dumped the core, and `xxxxxx` is a character string generated by the system in order to make the file name unique.

3. Highlight **Apply**, and press return.

### 6.2.7 Saving a Test Session Configuration for Repeated Use (Option Files)

You can use the Option Files feature to save the current set of selected devices and test options for reuse. This is a convenient feature when you plan to use the same test session configuration over and over again.

The configuration information is saved in a filename of your choice in the `/var/opt/SUNWvts/options` directory.

**Note** — Do not manually edit any option file. Unnecessary or spurious characters in the option file can cause unexpected behavior when you use them.

▼ To Create an Option File

1. **Configure SunVTS for the test session that you want to save.**
   
   See “To Configure SunVTS for a Test Session” on page 6-4.

2. **Highlight option_files in the Control panel, and press return.**
   
   The Option Files menu box is displayed.

3. **Specify an option file name in the Option File field.**

4. **Highlight Store, and press return.**

▼ To Load an Option File

**Note** — Loading an option file that was created on another system is permitted, but you must make sure that the configuration is valid for the system you plan to test.
Note – Do not load an option file that was created in a 64-bit environment into a 32-bit environment.

1. Highlight `option_files` in the Control panel, and press return.
   The `Option Files` menu box is displayed.

   The list of available option files is displayed.

3. Highlight an option file from the list, and press return.

   The test session configuration is loaded into SunVTS. You can use this configuration, or modify it before you start the test session.

▼ To Remove an Option File

1. Highlight `option_files` in the Control panel, and press return.
   The `Option Files` menu box is displayed.

   The list of available option files are displayed.

3. Highlight the option file from the list that you want to delete, and press return.


6.2.8 Using the Auto-Start Feature

You can use the auto-start feature, along with saved option files, to simplify the process of configuring a test session and running it.

▼ To Configure SunVTS to use the Auto-Start Feature

1. Highlight `set_options` from the Control panel, and press return.
   The `set_options` menu is displayed.

   The `Schedule` menu is displayed.

3. Enable the Auto Start setting in the `Schedule` menu.

5. Create an option file as described in “To Create an Option File” on page 6-22. The option file that you create is configured to use the auto-start feature.

▼ To Use the Auto-Start Feature

1. Highlight quit UI and Kernel from the quit menu in the Control panel. You must quit SunVTS and restart it for the auto-start feature to work.

2. Use the following command to restart SunVTS from the command-line, specifying the Option File that you created:

   ```
   # /opt/SUNWvts/bin/sunvts -to option_file
   ```

   SunVTS displays the TTY main window and automatically starts the test session.

6.2.9 Suspending and Resuming a Test Session

You can suspend a test session. For example, you might want to look at messages on the Console panel that have scrolled out of view, or you may want to view and print a log file.

▼ To Suspend and Resume a Test Session

1. While the test session is running, highlight suspend in the Control panel, and press return.
   “Suspended” is displayed in the Status panel, and the test session pauses until you resume it.

2. While the test session is suspended, highlight resume in the Control panel, and press return.
   “Testing” is displayed in the Status panel, and the SunVTS kernel resumes the suspended test session.
6.2.10 Recording and Replaying a Test Session

You can use the Record and Replay feature to record a SunVTS test session. Only one test session recording is saved at a time.

The events are recorded in a file called /var/opt/SUNWvts/vts_replay_file.

Once a test session is recorded, you can use the recorded events to drive the SunVTS kernel so it reproduces the recorded sequence of events at a later time.

**Note** – The Record and Replay feature closely reproduces the sequence of events, but it cannot reproduce the time periods of these events because the execution times vary from one run to another.

▼ To Record and Replay a Test Session

1. **Configure SunVTS for the test session that you want to run.**
   
   See “To Configure SunVTS for a Test Session” on page 6-4.

2. **Highlight start in the Control panel and press return.**
   
   The start menu is displayed.

3. **Highlight Start with Record and press return.**
   
   The test session runs, and the events are recorded. When testing stops, the recorded session is available to replay.

4. **Highlight start in the Control panel and press return.**
   
   The start menu is displayed.

5. **Highlight Replay and press return.**
   
   The kernel reruns the same tests, with the same configuration that you specified.

**Note** – During the replay, the kernel is actually rerunning the tests, not just re-displaying the recorded session.
This appendix provides descriptions of each SunVTS main window and dialog box. See the following:

SunVTS Main Windows:
- “CDE Main Window” on page A-2
- “OPEN LOOK Main Window” on page A-6
- “TTY Main Window” on page A-8

SunVTS Dialog Boxes:
- “Advanced” on page A-9
- “Auto Configuration” on page A-11
- “Connect to Host” on page A-12
- “DSched” on page A-13
- “Notify” on page A-15
- “Option Files” on page A-16
- “Schedule” on page A-17
- “Test Execution” on page A-18
- “Test Parameter” on page A-20
- “Thresholds” on page A-22
- “Trace Test” on page A-24
A.1 SunVTS Main Windows

A.1.1 CDE Main Window

FIGURE A-1  SunVTS CDE Main Window
TABLE A-1  SunVTS CDE Main Window

<table>
<thead>
<tr>
<th>Window Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Menu Bar    | Provides access to a variety of SunVTS controls through the following pull-down menus:  
  **Commands Menu:**  
  • Start testing: Starts enabled tests, records a test session, or replays a recorded test session  
  • Stop: Stops testing  
  • Reset: Sets pass/error count to zero; pauses  
  • Suspend: Pauses active tests  
  • Resume: Resumes testing  
  • Connect to Host: Connects to another machine running SunVTS kernel  
  • Trace test: traces enabled tests  
  • Reprobe system: probes system again  
  • Quit SunVTS: quits the following: UI and Kernel, UI only, Kernel only  
  **View Menu:**  
  • Open System map  
  • Close System map  
  **Options Menu** (detailed descriptions of each menu are provided in this chapter):  
  • Thresholds  
  • Notify  
  • Schedule  
  • Test execution  
  • Advanced  
  • Option files  
  **Reports Menu:**  
  Displays, prints, or removes log file information.  
  **DSched Menu:**  
  • Start DS—starts the Deterministic Scheduler feature and displays the Deterministic Scheduler dialog box.  
  • Show DS—displays the Deterministic Scheduler dialog box after you quit the DS UI.  
  • Quit Options—provides access to the following quit options:  
    • Quit DS UI only—quits the Deterministic Scheduler dialog box and leaves the Deterministic Scheduler running.  
    • Quit DS—quits the Deterministic Scheduler dialog box and stops the Deterministic Scheduler.  
  **Help Menu:**  
  • Shows the SunVTS version  
  • Displays the Solaris/SunVTS release table |
Quick Access buttons
Provides easy access to the most commonly used SunVTS controls:
- Start—starts the test session.
- Stop—stops the test session.
- Reset—sets the pass and error counts to zero, the test colors to black, and the system status information to zero.
- Host—opens the Connect to Host dialog box.
- Log—opens the Log Files dialog box.
- Meter—opens the Performance meter panel.
- Quit—closes the SunVTS UI and leaves the SunVTS kernel running.

Status panel
Displays the overall SunVTS testing status as follows:
- Hostname—indicates the name of the system under test
- Model—indicates the model of the system under test
- Testing status—provides the following status of SunVTS:
  - ds_idle—the deterministic scheduler is invoked, but is not testing
  - ds_running—the deterministic scheduler is invoked and is running a sequence
  - ds_suspended—the deterministic scheduler is invoked and a sequence is suspended
  - Idle—no testing is taking place
  - Replay—a previously recorded test session is displayed
  - Stopping—is momentarily displayed when a test session stops
  - Suspend—a test session is suspended
  - Testing—a test session is running
- System passes—displays the total number of successful system passes (a system pass is when all tests have been run once).
- Cumulative errors—the total number of errors from all tests
- Elapsed test time—indicates the total number of hours, minutes, and seconds that elapsed during testing.
- Last Option File—displays the name of the last option file that was accessed.
- AC Coverage—displays the type of Auto Configuration coverage level that was selected (either confidence, comprehensive, or no_coverage when the AC feature is not in use).

Select Devices panel
Provides buttons that control the devices that are selected for testing. This panel also provides the button used to enable intervention mode.

<table>
<thead>
<tr>
<th>Window Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Access buttons</td>
<td>Provides easy access to the most commonly used SunVTS controls:</td>
</tr>
<tr>
<td></td>
<td>- Start—starts the test session.</td>
</tr>
<tr>
<td></td>
<td>- Stop—stops the test session.</td>
</tr>
<tr>
<td></td>
<td>- Reset—sets the pass and error counts to zero, the test colors to black, and the system status information to zero.</td>
</tr>
<tr>
<td></td>
<td>- Host—opens the Connect to Host dialog box.</td>
</tr>
<tr>
<td></td>
<td>- Log—opens the Log Files dialog box.</td>
</tr>
<tr>
<td></td>
<td>- Meter—opens the Performance meter panel.</td>
</tr>
<tr>
<td></td>
<td>- Quit—closes the SunVTS UI and leaves the SunVTS kernel running.</td>
</tr>
<tr>
<td>Status panel</td>
<td>Displays the overall SunVTS testing status as follows:</td>
</tr>
<tr>
<td></td>
<td>- Hostname—indicates the name of the system under test</td>
</tr>
<tr>
<td></td>
<td>- Model—indicates the model of the system under test</td>
</tr>
<tr>
<td></td>
<td>- Testing status—provides the following status of SunVTS:</td>
</tr>
<tr>
<td></td>
<td>- ds_idle—the deterministic scheduler is invoked, but is not testing</td>
</tr>
<tr>
<td></td>
<td>- ds_running—the deterministic scheduler is invoked and is running a sequence</td>
</tr>
<tr>
<td></td>
<td>- ds_suspended—the deterministic scheduler is invoked and a sequence is suspended</td>
</tr>
<tr>
<td></td>
<td>- Idle—no testing is taking place</td>
</tr>
<tr>
<td></td>
<td>- Replay—a previously recorded test session is displayed</td>
</tr>
<tr>
<td></td>
<td>- Stopping—is momentarily displayed when a test session stops</td>
</tr>
<tr>
<td></td>
<td>- Suspend—a test session is suspended</td>
</tr>
<tr>
<td></td>
<td>- Testing—a test session is running</td>
</tr>
<tr>
<td></td>
<td>- System passes—displays the total number of successful system passes (a system pass is when all tests have been run once).</td>
</tr>
<tr>
<td></td>
<td>- Cumulative errors—the total number of errors from all tests</td>
</tr>
<tr>
<td></td>
<td>- Elapsed test time—indicates the total number of hours, minutes, and seconds that elapsed during testing.</td>
</tr>
<tr>
<td></td>
<td>- Last Option File—displays the name of the last option file that was accessed.</td>
</tr>
<tr>
<td></td>
<td>- AC Coverage—displays the type of Auto Configuration coverage level that was selected (either confidence, comprehensive, or no_coverage when the AC feature is not in use).</td>
</tr>
<tr>
<td>Select Devices panel</td>
<td>Provides buttons that control the devices that are selected for testing. This panel also provides the button used to enable intervention mode.</td>
</tr>
</tbody>
</table>
Select mode panel

Provides buttons that control the test mode:

- Connection test mode—provides a low-stress, quick testing of the availability and connectivity of selected devices. These tests are non-intrusive, meaning they will release the devices after a quick test, and they will not place a heavy load on system activity.

- Functional test mode—provides more robust testing of your system and devices. It will use your system resources for thorough testing and it assumes that no other applications are running.

- Auto Functional mode—opens the Automatic Configuration dialog box which provides access to the Automatic Configuration feature. The Automatic Configuration feature simplifies the test session configuration steps that you perform by automatically selecting a consistent and reliable set of test options for the platform under test. See “Using the Automatic Configuration Feature” on page 4-19 for instructions on using this feature.

System Map

Displays selectable devices and provides access to control the individual selection and testing attributes for each device. The following items are displayed in the System Map:

- Groups—represents a collection of devices. If you select a group for testing, all devices in that group are tested.

- Device—is the name of an individual device that is selectable for testing.

- Test name—is the name of the SunVTS test that is assigned to test the device. The test name is displayed in parentheses.

- Checkmark box —Specifies whether a device or device group is selected for testing.

- Colors—Indicate the state of devices; Red=test failure, Green=no failure, Black=device not tested.

- Asterisk * —indicates that the device is currently being tested.

Test Message panel

Displays test session messages.

### TABLE A-1 SunVTS CDE Main Window (Continued)

<table>
<thead>
<tr>
<th>Window Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select mode panel</td>
<td>Provides buttons that control the test mode:</td>
</tr>
<tr>
<td></td>
<td>• Connection test mode—provides a low-stress, quick testing of the availability and connectivity of selected</td>
</tr>
<tr>
<td></td>
<td>devices. These tests are non-intrusive, meaning they will release the devices after a quick test, and they</td>
</tr>
<tr>
<td></td>
<td>will not place a heavy load on system activity.</td>
</tr>
<tr>
<td></td>
<td>• Functional test mode—provides more robust testing of your system and devices. It will use your system</td>
</tr>
<tr>
<td></td>
<td>resources for thorough testing and it assumes that no other applications are running.</td>
</tr>
<tr>
<td></td>
<td>• Auto Functional mode—opens the Automatic Configuration dialog box which provides access to the Automatic</td>
</tr>
<tr>
<td></td>
<td>Configuration feature. The Automatic Configuration feature simplifies the test session configuration steps</td>
</tr>
<tr>
<td></td>
<td>that you perform by automatically selecting a consistent and reliable set of test options for the platform</td>
</tr>
<tr>
<td></td>
<td>under test. See “Using the Automatic Configuration Feature” on page 4-19 for instructions on using this</td>
</tr>
<tr>
<td></td>
<td>feature.</td>
</tr>
<tr>
<td>System Map</td>
<td>Displays selectable devices and provides access to control the individual selection and testing attributes</td>
</tr>
<tr>
<td></td>
<td>for each device. The following items are displayed in the System Map:</td>
</tr>
<tr>
<td></td>
<td>• Groups—represents a collection of devices. If you select a group for testing, all devices in that group are</td>
</tr>
<tr>
<td></td>
<td>tested.</td>
</tr>
<tr>
<td></td>
<td>• Device—is the name of an individual device that is selectable for testing.</td>
</tr>
<tr>
<td></td>
<td>• Test name—is the name of the SunVTS test that is assigned to test the device. The test name is displayed</td>
</tr>
<tr>
<td></td>
<td>in parentheses.</td>
</tr>
<tr>
<td></td>
<td>• Checkmark box —Specifies whether a device or device group is selected for testing.</td>
</tr>
<tr>
<td></td>
<td>• Colors—Indicate the state of devices; Red=test failure, Green=no failure, Black=device not tested.</td>
</tr>
<tr>
<td></td>
<td>• Asterisk * —indicates that the device is currently being tested.</td>
</tr>
</tbody>
</table>

1. To increase or decrease a numeric value in a SunVTS CDE dialog box, you can either use the up or down arrows, or type a new value in the text box and press Return. Press Apply to apply all dialog box changes.
A.1.2 OPEN LOOK Main Window

![SunVTS OPEN LOOK Main Window](image)

**FIGURE A-2** SunVTS OPEN LOOK Main Window

**TABLE A-2** SunVTS OPEN LOOK Main Window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status panel</td>
<td>Displays the overall SunVTS testing status.</td>
</tr>
<tr>
<td>Performance Meter panel</td>
<td>Displays a graphical representation of the activity of various subsystems.</td>
</tr>
<tr>
<td>Control panel</td>
<td>Provides access to SunVTS controls.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Test Status panel</td>
<td>Displays the devices under test and pass fail counts.</td>
</tr>
<tr>
<td>Message panel</td>
<td>Displays SunVTS messages.</td>
</tr>
<tr>
<td>Test Selector panel</td>
<td>Provides access to the selectable devices and associated test options.</td>
</tr>
</tbody>
</table>
A.1.3 TTY Main Window

![TTY Main Window Diagram]

**FIGURE A-3** SunVTS TTY Main Window

**TABLE A-3** SunVTS TTY Main Window

<table>
<thead>
<tr>
<th>Window Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control panel</td>
<td>Provides access to SunVTS commands and options.</td>
</tr>
<tr>
<td>Test_Groups panel</td>
<td>Shows the testable devices (categorized in groups) and provides access to their test options.</td>
</tr>
<tr>
<td>Status panel</td>
<td>Displays SunVTS test status information.</td>
</tr>
<tr>
<td>Message panel</td>
<td>The area where test messages are displayed. No user input is accepted in this panel.</td>
</tr>
</tbody>
</table>
A.2 SunVTS Dialog Boxes

A.2.1 Advanced

FIGURE A-4  Advanced Dialog Boxes

TABLE A-4  Advanced Dialog Box Descriptions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Override</td>
<td>Sets all options for all tests to the settings made at the system level. Supersedes the group-specific and device-level option settings in favor of the options set at the global level.</td>
</tr>
</tbody>
</table>
### TABLE A-4  Advanced Dialog Box Descriptions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Override</td>
<td>Supersedes the device-level test options in favor of the group options. The System Override option supersedes this option.</td>
</tr>
<tr>
<td>Group Lock</td>
<td>Protects specific group options from being changed from the options set at the system level (the System Override option supersedes this option).</td>
</tr>
<tr>
<td>Test Lock</td>
<td>Protects device-level options from being changed from options set at the group or system level (the System Override and Group Override options supersedes this option).</td>
</tr>
</tbody>
</table>
A.2.2 Auto Configuration

![Auto Configuration Dialog Box](image)

**FIGURE A-5** Auto Configuration Dialog Box

**TABLE A-5** Auto Configuration Dialog Box Descriptions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comprehensive</td>
<td>Sets all the test options for thorough testing. All applicable functional tests are enabled. The test session validates the full functionality of the system and provides you with assurance that the system is hardware fault free.</td>
</tr>
<tr>
<td>Confidence</td>
<td>Sets all the test options such that there is limited functional test coverage as compared to the Comprehensive level of coverage. The Confidence level testing verifies the main functionality of the system in a shorter amount of time.</td>
</tr>
</tbody>
</table>

**Note** – The Help button displays a dialog box with Auto Configuration information and instructions.

**Note** – The Auto Configuration feature is only available from the SunVTS CDE UI.
A.2.3 Connect to Host

FIGURE A-6 Connect to Host Dialog Boxes

TABLE A-6 Connect to Host Dialog Box Descriptions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to Host</td>
<td>Specifies the hostname of the system to which you want to connect. The host you specify must be running the SunVTS kernel (the same version as the local UI), and you must have permission.</td>
</tr>
<tr>
<td>Hostname List</td>
<td>Displays the list of hosts that this UI has connected to, making them available for future connections. This list is cleared when you quit SunVTS.</td>
</tr>
</tbody>
</table>
A.2.4 DSched

![Deterministic Scheduler Dialog Boxes](image)

**FIGURE A-7** Deterministic Scheduler Dialog Boxes

<table>
<thead>
<tr>
<th>Dialog Box Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commands</td>
<td>Provides access to the following Deterministic Scheduler quit commands: Quit UI Only—quits the Deterministic Scheduler dialog box and leaves the Deterministic Scheduler running. Quit DS and UI—quits the Deterministic Scheduler dialog box and stops the Deterministic Scheduler.</td>
</tr>
<tr>
<td>Sequence Name</td>
<td>A field used to specify a unique sequence name for a group of tasks that are listed in the Tasks in Sequence area. You can access existing sequences by clicking on the down arrow that is next to this field. The Sequence Name buttons provide the following functions: Store—saves the named sequence for future use. Remove—deletes the named sequence. Close—quits the Deterministic Scheduler dialog box and leaves the Deterministic Scheduler running.</td>
</tr>
<tr>
<td>Tasks in Sequence</td>
<td>Lists the tasks in a specific order for the current sequence.</td>
</tr>
<tr>
<td>Insert and Delete buttons</td>
<td>Inserts and deletes tasks from the Tasks in Sequence area.</td>
</tr>
</tbody>
</table>
Select Edit|Run Specifies the Deterministic Scheduler panel as follows:
Edit—displays the Deterministic Scheduler edit panel. In this panel, the Scheduler is ready for you to create, load, and remove tasks and sequences.
Run—displays the Deterministic Scheduler run panel. In this panel, the Scheduler is ready for you to define the number of times (loops) for a sequence to run, start, suspend, resume, stop, and reset the Deterministic Scheduler.

Edit panel Appears when the Select radio button is set to Edit. The following functions are displayed:
- Task Name—a field used to specify a task name. A task is a group of tests that are selected in the SunVTS main window.
- Available Tasks—shows a list of existing tasks.
- Load—loads the selected task into the SunVTS main window.
- Store—saves the task.
- Remove—deletes the selected task from the task list.

Run panel Appears when the Select button is set to Run. The following functions are displayed:
- Total Loops—specifies the number of times to run a sequence.
- Current Loop—displays each loop number as a sequence runs.
- Start—Starts running the sequence that is specified in the Sequence Name field.
- Stop—stops the running sequence.
- Suspend—pauses a running sequence.
- Resume—resumes a suspended sequence.
- Reset—resets the SunVTS main window and the sequence dialog box.

Note – The Help button displays a dialog box with Deterministic Scheduler information and instructions.

Note – The Deterministic Scheduler is only available from the SunVTS CDE UI.
A.2.5 Notify

FIGURE A-8 Notify Dialog Boxes

TABLE A-8 Notify Dialog Box Descriptions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Send Email     | Determines when and if you want the test status messages sent to you by email. From this menu, you can choose:  
|                | • Disabled—never send email.  
|                | • Now —send email immediately.  
|                | • On Error —send email when an error occurs.  
|                | • Periodically —send email with a time period set in the Log Period option.  
|                | • On Error & Periodically —send email periodically as well as when an error occurs. |
| Email Address  | Indicates the email address where the test status messages are sent (the address is root by default). |
| Log Period     | Specifies the time, in minutes, between sending test status email messages. |
A.2.6 Option Files

FIGURE A-9 Option Files Dialog Boxes

TABLE A-9 Option Files Dialog Box Descriptions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option Files</td>
<td>Opens the Option Files dialog box. Use this dialog box to name and store a SunVTS configuration for future use. Later, you can open this dialog box to select and load an option file for quick SunVTS configuration.</td>
</tr>
<tr>
<td>Option File List</td>
<td>Displays the list of option files, from which you choose to load, or remove.</td>
</tr>
</tbody>
</table>
A.2.7 Schedule

FIGURE A-10 Schedule Dialog Boxes

TABLE A-10 Schedule Dialog Box Descriptions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Start</td>
<td>Eliminates the need to use the Start button to start a SunVTS testing session. To use this option see “Using the Auto-Start Feature” on page 4-28.</td>
</tr>
<tr>
<td>Single Pass</td>
<td>Runs only one pass of each selected test.</td>
</tr>
<tr>
<td>System Concurrency</td>
<td>Sets the maximum number of test instances that can be run concurrently on the machine being tested.</td>
</tr>
<tr>
<td>Group Concurrency</td>
<td>Sets the number of tests you want to run at the same time in the same group.</td>
</tr>
</tbody>
</table>
A.2.8 Test Execution

FIGURE A-11 Test Execution Dialog Boxes
### TABLE A-11  Test Execution Dialog Box Descriptions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stress</td>
<td>Runs certain functional mode tests in stress mode, working the selected devices harder than non-stress mode functional testing. Note: This option will be removed in a future version of SunVTS.</td>
</tr>
<tr>
<td>Verbose</td>
<td>Displays verbose messages in the SunVTS messages window.</td>
</tr>
<tr>
<td>Core File</td>
<td>When enabled, creates a core file when a test session results in a core dump. When Core File is disabled, a core file is not created. Instead, a message is displayed and logged, indicating the signal that caused the failure. See “Using the Debugging Features” on page 4-26.</td>
</tr>
<tr>
<td>Run On Error</td>
<td>When disabled, SunVTS stops testing when an error is encountered. When enabled, SunVTS continues to run until the Max errors value is reached.</td>
</tr>
<tr>
<td>Max Passes</td>
<td>Specifies the maximum number of test passes for all selected devices. The default is 0 (zero) which means there is no limit.</td>
</tr>
<tr>
<td>Max Errors</td>
<td>(Only enabled when the Run On Error option is enabled) Specifies the maximum number of allowable errors before stopping the test session. The default is 0 (zero) which directs the SunVTS kernel to continue testing in the event of all errors.</td>
</tr>
<tr>
<td>Max Time</td>
<td>Specifies the time limit, in minutes, that a test session can run. The default is 0 (zero) which means there is no time limit.</td>
</tr>
<tr>
<td>Delay Time</td>
<td>Specifies, in seconds, the amount of time to pause between execution of a test. This option results in differing test behavior based on the level for which this option is specified:</td>
</tr>
<tr>
<td></td>
<td>• System level—the delay is performed between the execution of all selected tests.</td>
</tr>
<tr>
<td></td>
<td>• Group level—the delay is performed between the execution of selected tests in this group.</td>
</tr>
<tr>
<td></td>
<td>• Device level—the delay is performed between the execution of the test for this device.</td>
</tr>
<tr>
<td></td>
<td>Select a value from 0 to 60. Zero (0), the default, performs no delay. This option offers testing convenience for tests such as graphic device tests, where adding a delay between test execution provides a period of time for you make selections in the SunVTS main window.</td>
</tr>
<tr>
<td>Number of Instances</td>
<td>Specifies the number of instances to run each scalable test.</td>
</tr>
</tbody>
</table>
A.2.9 Test Parameter

FIGURE A-12 Test Parameter Dialog Boxes

---

**Note** – Except for the lower buttons, this menu is different for each device. For descriptions of each different Test Parameter Options Dialog Box, refer to the *SunVTS Test Reference Manual*. 
### TABLE A-12  Test Parameter Options Dialog Box Descriptions (Generic Lower Buttons)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Affinity</td>
<td>Only available on multiprocessor systems, used to specify on which processor you want to run all tests. To select the specific processor, click the processor number. If no processor is specified, the operating system randomly distributes testing among all the processors. Note: when you use random distribution, you cannot verify that all processors have been tested.</td>
</tr>
<tr>
<td>Within Instance</td>
<td>Provides the means to apply the settings:</td>
</tr>
<tr>
<td></td>
<td>• to this device only with the Apply button, or</td>
</tr>
<tr>
<td></td>
<td>• to all devices within this group with the Apply to Group button, or</td>
</tr>
<tr>
<td></td>
<td>• to all devices (of the same device type for all controllers) with the Apply to All button.</td>
</tr>
<tr>
<td></td>
<td>The option settings are only applied to one instance of the test.</td>
</tr>
<tr>
<td>Across All Instances</td>
<td>Provides the means to apply the settings globally:</td>
</tr>
<tr>
<td></td>
<td>• to this device only with the Apply button, or</td>
</tr>
<tr>
<td></td>
<td>• to all devices within this group with the Apply to Group button, or</td>
</tr>
<tr>
<td></td>
<td>• to all devices (of the same device type for all controllers) with the Apply to All button.</td>
</tr>
<tr>
<td></td>
<td>The option settings are applied to all instances.</td>
</tr>
<tr>
<td>Reset</td>
<td>Returns the option values to their default settings and closes the test parameter option menu.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Ignores any changes made to option values and closes the test parameter option menu.</td>
</tr>
</tbody>
</table>
A.2.10 Thresholds

FIGURE A-13 Threshold Dialog Boxes

TABLE A-13 Threshold Dialog Box Descriptions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max System Passes</td>
<td>Specifies the maximum number of system passes before stopping all tests. The default of 0 (zero) causes the SunVTS kernel to run the tests until you click the Stop button. Note: The definition of a system pass is when all selected tests have run one time.</td>
</tr>
</tbody>
</table>
Max System Errors | Specifies the maximum number of system errors before SunVTS stops all tests. The default is 0 (zero), which causes the SunVTS kernel to continue testing regardless of errors.
Max System Time | Specifies the maximum number of minutes that SunVTS continues testing. The default of 0 (zero) makes the SunVTS kernel run the selected tests until you click the Stop button.
Max System Log Size | Specifies the maximum size of the SunVTS error log file (/var/opt/SUNWvts/logs/sunvts.err), the SunVTS kernel error log (/var/opt/SUNWvts/logs/vtsk.err) and the info log file (/var/opt/SUNWvts/logs/sunvts.info) in Mbytes. The default is 1 Mbyte. Specify an integer from 1 to 5.
A.2.11 Trace Test

![CDE and OPEN LOOK Trace Test Dialog Boxes](image)

FIGURE A-14 Trace Test Dialog Boxes

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Test panel</td>
<td>Displays the tests that are available to select for tracing.</td>
</tr>
<tr>
<td>Console/File button</td>
<td>Specifies whether to send the trace messages to the message panel, or to</td>
</tr>
<tr>
<td></td>
<td>the trace file (/var/opt/SUNWvts/logs/sunvts.trace).</td>
</tr>
</tbody>
</table>

**Note** – The Trace mode dialog box is only available from the SunVTS CDE or OPENLOOK UI.
Frequently Asked Questions

1. Which version of SunVTS should I install?

For a supported SunVTS installation, install the version of SunVTS that shipped with your Solaris release on the Solaris Supplement CD. TABLE B-1 lists the Solaris Operating Environment release to SunVTS version correspondence.

<table>
<thead>
<tr>
<th>Solaris Operating Environment Release</th>
<th>SunOS Version</th>
<th>SunVTS Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 7/01</td>
<td>5.8</td>
<td>4.4</td>
</tr>
<tr>
<td>8 4/01</td>
<td>5.8</td>
<td>4.3</td>
</tr>
<tr>
<td>8 1/01</td>
<td>5.8</td>
<td>4.2</td>
</tr>
<tr>
<td>8 10/00</td>
<td>5.8</td>
<td>4.1</td>
</tr>
<tr>
<td>8 6/00</td>
<td>5.8</td>
<td>4.0</td>
</tr>
<tr>
<td>8</td>
<td>5.8</td>
<td>4.0</td>
</tr>
<tr>
<td>7 11/99</td>
<td>5.7</td>
<td>3.4</td>
</tr>
<tr>
<td>7 8/99</td>
<td>5.7</td>
<td>3.3</td>
</tr>
<tr>
<td>7 5/99</td>
<td>5.7</td>
<td>3.2</td>
</tr>
<tr>
<td>7 3/99</td>
<td>5.7</td>
<td>3.1</td>
</tr>
<tr>
<td>7</td>
<td>5.7</td>
<td>3.0</td>
</tr>
<tr>
<td>2.6 5/98</td>
<td>5.6</td>
<td>2.1.3</td>
</tr>
<tr>
<td>2.6 3/98</td>
<td>5.6</td>
<td>2.1.2</td>
</tr>
<tr>
<td>2.5.1 11/97</td>
<td>5.5.1</td>
<td>2.1.1</td>
</tr>
</tbody>
</table>
2. Can I install SunVTS in a directory other than the default (/opt)_CF?  
Yes. See Chapter 2 “Installing and Removing SunVTS”.

3. Will installing SunVTS negatively affect any of the existing files on my system?
No. SunVTS follows standard packaging conventions, installing cleanly in your environment, and can be removed cleanly with the `pkg rm` command.

4. Can I install multiple versions of SunVTS on my system?
No. Only one installation of SunVTS is supported on a given system.

5. If I reinstall SunVTS, will I have access to the options files that were created before the reinstall?
Yes. The option files are not affected by installation or deinstallation.

6. Can I install and run SunVTS on my x86 system that is running the Solaris Operating Environment?
No. SunVTS is not ported to Solaris on x86. SunVTS is only supported on Sun SPARC/Solaris environments.

7. Can I run SunVTS directly from the Solaris Supplement CD that contains SunVTS?
No. You must install SunVTS as described in Chapter 2 “Installing and Removing SunVTS” on each system for which you plan to run SunVTS.

8. Can I run SunVTS from maintenance-mode (single-user level)?
No. Your system must be running multi-user mode.

9. Can I run SunVTS through the Sun Management Center application (formerly known as Sun Enterprise SyMON)?
No. SunVTS is installed and run independently.

10. I know that SunVTS runs on my 32-bit Solaris Operating Environment systems. Will it run on my Solaris 64-bit Operating Environment systems?
Yes. The `sunvts` command detects which operating environment is running and starts the appropriate SunVTS kernel. You must have the 64-bit SunVTS package installed (`SUNWvtsx`) to run 64-bit tests. See “SunVTS Packages” on page 2-2.
11. Can I run SunVTS by specifying an option file that is located on another system in the network?

No. The directory where SunVTS expects to find an option file is hardcoded to the local system where SunVTS is running.

12. Are any of the SunVTS tests “data destructive”?

No, SunVTS tests are not data destructive. However, when the disktest is run with the rawtest write/read mode enabled, it does write data on the selected partition. The test, however, backs up the original data first, and puts it back when the write/read/compare operation is complete. By default, disktest runs in read-only mode. In addition, a few intervention mode tests, such as tapetest and disktest (for the floppy drive) require that you load scratch media that can be written on. Specific test details are explained in the SunVTS Test Reference Manual.

13. If I add a device to my system, how do I get SunVTS to recognize the device?

Once the Solaris Operating Environment recognizes the device (either through a boot -r or another configuration command), SunVTS uses probe routines to recognize the device. The probe routines run automatically when SunVTS is started. Also, you can have SunVTS probe your system for devices at any time with the SunVTS reprobe command.

14. Can I customize any of the SunVTS options or menus?

No.

15. Can I add my own tests to the SunVTS environment?

Yes. See “Adding a Custom Test” on page 2-15.

16. Why does it take SunVTS a long time to start, and a long time to complete a reprobe?

When SunVTS starts (performing the initial probe), and during a reprobe, SunVTS has to determine your system configuration and initiate the tests that correspond specifically to your system. If your system has many devices, the probe takes a while to complete.

17. One of my devices does not appear in the SunVTS UI. Why not?

First, the Solaris Operating Environment must recognize a device before SunVTS can see it. Make sure that the operating environment is aware of the device (perform a boot -r if necessary). Second, the device might have had a failure when SunVTS probed it. Check the window where you started SunVTS to see if any errors are reported that might direct you to the problem. Third, while most Sun devices have a corresponding test in SunVTS (and therefore show up in the SunVTS UI), you might have a device that is not supported by SunVTS.
18. What should I do if the SunVTS appears hung?

First, give SunVTS some time to run the tests. Sometimes the tests use so much of the system resources that there is a delay in updating the SunVTS UI, and it appears hung. Second, if you determine that SunVTS is indeed hung, it might be caused by one specific test. Try deselecting the test that is indicated as currently running. You can start another UI (see “Starting the SunVTS Kernel and Interface Separately” on page 3-7) to control SunVTS.

19. I cannot select trace mode for one of my devices because it does not show up in the trace mode dialog box. Why?

You are probably using the physical view, which causes some devices to be listed several levels below what the trace dialog box can display. Try selecting the logical view. You will probably be able to locate the device.

20. How can I identify the name of the test for a given device?

The test name is enclosed in parentheses and displayed next to the device in the SunVTS UI. For example, the test for the memory device is displayed as mem(pmtest), where mem is the device and pmtest is the name of the test.

21. I get errors when I run my frame buffer test, but the frame buffer is functional. Why?

Testing frame buffers requires special considerations. In some cases you must disable the screen saver, enable a frame buffer lock option, and other steps. Sometimes the smallest mouse or keyboard input will cause the test to fail. Refer to the specific frame buffer test in the SunVTS Test Reference Manual for details.

22. I have a script that relies on the old SunVTS message syntax (pre-SunVTS 4.0). The script does not work with the new message syntax. What can I do?

The best action is to update your script to use the new message format (see TABLE 4-2).

The new SunVTS message format:

```
<timestamp> <hostname> "SunVTS<version_id>:" [VTSID <vtsmsgid>
<modulename>[.[<submodulename>][.[<instnum>][.(#P)].<vts_msgtype>]
[<device_pathname>:] <msg_text>
```

New message example:

```
04/24/00 17:19:47 systemA SunVTS4.4: VTSID 34 disktest.VERBOSE
c0t0d0: "number of blocks 3629760"
```
In the event that you have a script that relies on the old message format, there is a SunVTS environment variable, VTS_OLD_MSG, that you can set so that SunVTS messages are displayed using the old message format. To use the old message format, set the environment variable VTS_OLD_MSG to YES.

The old message format will not be supported in future SunVTS releases. The VTS_OLD_MSG variable should only be used temporarily until your script is updated to recognize the new message format.

The old SunVTS message format:

```
SUNWvts.<modulename>[<submodulename>].<vts_msgid> <timestamp>
<modulename>[<instnum>][(#P)] <device_pathname|hostname>
<vts_msgtype>: <msg_text>
```

Old message example:

```
SUNWvts.disktest.34 04/24/99 14:27:30 disktest c0t0d0 VERBOSE:
"number of blocks 3629760"
```

23. **During a SunVTS installation, I was asked if I wanted to create a new instance of this package. What does this mean?**

This is an indication that one or more of the SunVTS packages are already installed. You should remove them before installing the new ones. See Chapter 2 “Installing and Removing SunVTS” for the procedures.

24. **Sometimes the SunVTS CDE UI (vtsui) fails to start, or while running, it exits with “X Error of failed request”. What can I do to correct this problem?**

This type of error usually indicates that there is an X server resource issue. Try closing some of your other GUI application windows and restart the SunVTS UI (vtsui).

25. **Why do I get the following error when I select c1t0d0 in a multi-path configuration?**

```
ERROR:c1t0d0’s alternate path (c2t0d0) is already selected
```

This type of error indicates that a disk drive was already selected and you tried to select it again using one of its alternate multi-path device names. SunVTS does not permit the selection of multiple paths of the same device.
Index

A
accessing SunVTS man pages, 2-6
Across All Instances, A-21
Across All Instances (CDE), 4-13
Across All Instances (TTY), 6-11
additional features with the
CDE UI, 4-18
OPEN LOOK UI, 5-12
TTY UI, 6-16
Advanced dialog box (all UIs), A-9
Applications and SunVTS, 3-1
Apply, 4-12
Apply to All, 4-13
Apply to Group, 4-13
arrow keys, 6-4
asterisk, 4-14
Auto Config mode, 4-5
Auto Start, A-17
Automatic Configuration, 4-19, A-5
Comprehensive testing, A-11
Confidence testing, A-11
dialog box, 4-19, A-11
using the, 4-19
auto-start feature (CDE), 4-28
auto-start feature (OL), 5-20
auto-start feature (TTY), 6-23
binding a test (CDE), 4-26
binding a test (OL), 5-17
binding a test (TTY), 6-21
boot -r, B-3
BYPASS_FS_PROBE, 2-13

C
CDE display mode, 4-6
CDE main window, 4-2, A-2
CDE UI
Status panel, 4-4, A-4
Test mode panel, 4-5, A-5
CD-ROM drive preparation, 3-4
changing windows (TTY), 6-4
checking for test messages (TTY), 6-13
clearing the current results (CDE), 4-18
closing the Log file window (CDE), 4-15
collapsing the list of devices (CDE), 4-8
color indications, 4-14
Commands menu (DS), A-13
communication port preparation, 3-4
complete service name, SEAM, 2-4, 2-11
Comprehensive testing, A-11
Confidence testing, A-11
configuring a test session (CDE), 4-4
configuring a test session (OL), 5-3
configuring a test session (TTY), 6-4
Connect to Host dialog box (all UIs), A-12
Connect to Host field, 4-21, A-12
connecting to another host (CDE), 4-21
connecting to another host (OL), 5-12

B
background mode, 1-6
backspace key, 6-4
backup logs, 4-22, 5-14, 6-18
basic security, 2-8
connecting to another host (TTY), 6-17
Connection test mode, 1-4, 4-5, A-5
Connection test mode (OL), 5-5
Connection test mode (TTY), 6-5
Consistent testing, 4-19
Control panel (OL), A-6
Control panel (TTY), 6-3, A-8
controlling security, 2-11
Core File option, A-19
core file option, 4-26
core file option (TTY), 6-22
Cumulative errors (CDE), 4-4, A-4
current device under test, 4-14
Current Loop (DS), A-14
custom test, installing a, 2-15

data destructive question, B-3
debugging features (CDE), 4-26
debugging features (OL), 5-18
debugging features (TTY), 6-21
decreasing testing intensity (CDE), 4-25
default directory, B-2
default installation directory (/opt), 2-3
default security, 2-12
Default selection, 4-9
Defining DSched tasks, 4-32
Defining the sequence loops, 4-36
Defining the Task Sequence, 4-34
Delete button (DS), A-13
deleting a log (CDE), 4-15
deleting text in field (TTY), 6-4
description of SunVTS, 1-1
Deterministic Scheduler, 4-30
deterministic Scheduler dialog box (all UIs), A-13
device, 4-9
device group, 4-9
device groups (TTY), 6-7
device preparation, 3-4
Device Selection panel, 4-9
device-level options (CDE), 4-12
device-level options (TTY), 6-10
devices in the System Map (CDE), 4-8
devices not appearing question, B-8
dialog boxes, A-1
disabling tracing (CDE), 4-23
discardng pop-up menus (TTY), 6-4
diskette drive preparation, 3-4
display mode (CDE), 4-6
display mode (OL), 5-4
display mode (TTY), 6-6
displaying a menu (TTY), 6-4
dsIdle, 4-4, A-4
ds_running, 4-4, A-4
ds_suspended, 4-4, A-4

data destructive question, B-3
debugging features (CDE), 4-26
debugging features (OL), 5-18
debugging features (TTY), 6-21
decreasing testing intensity (CDE), 4-25
default directory, B-2
default installation directory (/opt), 2-3
default security, 2-12
Default selection, 4-9
Defining DSched tasks, 4-32
Defining the sequence loops, 4-36
Defining the Task Sequence, 4-34
Delete button (DS), A-13
deleting a log (CDE), 4-15
deleting text in field (TTY), 6-4
description of SunVTS, 1-1
Deterministic Scheduler, 4-30
deterministic Scheduler dialog box (all UIs), A-13
device, 4-9
device group, 4-9
device groups (TTY), 6-7
device preparation, 3-4
Device Selection panel, 4-9
device-level options (CDE), 4-12
device-level options (TTY), 6-10
devices in the System Map (CDE), 4-8
devices not appearing question, B-8
dialog boxes, A-1
disabling tracing (CDE), 4-23
discardng pop-up menus (TTY), 6-4
diskette drive preparation, 3-4
display mode (CDE), 4-6
display mode (OL), 5-4
display mode (TTY), 6-6
displaying a menu (TTY), 6-4
dsIdle, 4-4, A-4
ds_running, 4-4, A-4
ds_suspended, 4-4, A-4

data destructive question, B-3
debugging features (CDE), 4-26
debugging features (OL), 5-18
debugging features (TTY), 6-21
decreasing testing intensity (CDE), 4-25
default directory, B-2
default installation directory (/opt), 2-3
default security, 2-12
Default selection, 4-9
Defining DSched tasks, 4-32
Defining the sequence loops, 4-36
Defining the Task Sequence, 4-34
Delete button (DS), A-13
deleting a log (CDE), 4-15
deleting text in field (TTY), 6-4
description of SunVTS, 1-1
Deterministic Scheduler, 4-30
deterministic Scheduler dialog box (all UIs), A-13
device, 4-9
device group, 4-9
device groups (TTY), 6-7
device preparation, 3-4
Device Selection panel, 4-9
device-level options (CDE), 4-12
device-level options (TTY), 6-10
devices in the System Map (CDE), 4-8
devices not appearing question, B-8
dialog boxes, A-1
disabling tracing (CDE), 4-23
discardng pop-up menus (TTY), 6-4
diskette drive preparation, 3-4
display mode (CDE), 4-6
display mode (OL), 5-4
display mode (TTY), 6-6
displaying a menu (TTY), 6-4
dsIdle, 4-4, A-4
ds_running, 4-4, A-4
ds_suspended, 4-4, A-4

data destructive question, B-3
debugging features (CDE), 4-26
debugging features (OL), 5-18
debugging features (TTY), 6-21
decreasing testing intensity (CDE), 4-25
default directory, B-2
default installation directory (/opt), 2-3
default security, 2-12
Default selection, 4-9
Defining DSched tasks, 4-32
Defining the sequence loops, 4-36
Defining the Task Sequence, 4-34
Delete button (DS), A-13
deleting a log (CDE), 4-15
deleting text in field (TTY), 6-4
description of SunVTS, 1-1
Deterministic Scheduler, 4-30
deterministic Scheduler dialog box (all UIs), A-13
device, 4-9
device group, 4-9
device groups (TTY), 6-7
device preparation, 3-4
Device Selection panel, 4-9
device-level options (CDE), 4-12
device-level options (TTY), 6-10
devices in the System Map (CDE), 4-8
devices not appearing question, B-8
dialog boxes, A-1
disabling tracing (CDE), 4-23
discardng pop-up menus (TTY), 6-4
diskette drive preparation, 3-4
display mode (CDE), 4-6
display mode (OL), 5-4
display mode (TTY), 6-6
displaying a menu (TTY), 6-4
dsIdle, 4-4, A-4
ds_running, 4-4, A-4
ds_suspended, 4-4, A-4

data destructive question, B-3
debugging features (CDE), 4-26
debugging features (OL), 5-18
debugging features (TTY), 6-21
decreasing testing intensity (CDE), 4-25
default directory, B-2
default installation directory (/opt), 2-3
default security, 2-12
Default selection, 4-9
Defining DSched tasks, 4-32
Defining the sequence loops, 4-36
Defining the Task Sequence, 4-34
Delete button (DS), A-13
deleting a log (CDE), 4-15
deleting text in field (TTY), 6-4
description of SunVTS, 1-1
Deterministic Scheduler, 4-30
deterministic Scheduler dialog box (all UIs), A-13
device, 4-9
device group, 4-9
device groups (TTY), 6-7
device preparation, 3-4
Device Selection panel, 4-9
device-level options (CDE), 4-12
device-level options (TTY), 6-10
devices in the System Map (CDE), 4-8
devices not appearing question, B-8
dialog boxes, A-1
disabling tracing (CDE), 4-23
discardng pop-up menus (TTY), 6-4
diskette drive preparation, 3-4
display mode (CDE), 4-6
display mode (OL), 5-4
display mode (TTY), 6-6
displaying a menu (TTY), 6-4
dsIdle, 4-4, A-4
ds_running, 4-4, A-4
ds_suspended, 4-4, A-4

grouping menu (TTY), 6-7
group-level options, 4-12
group-level options (OL), 5-6
group-level options (TTY), 6-10

H
Hostname in Status panel, 4-4, A-4
Hostname List, 4-21, A-12

I
Idle, 4-4, A-4
increase testing intensity (CDE), 4-25
INFO, 4-15
information log, 4-22, 5-13, 6-18
information log (CDE), 4-15, 5-10, 6-13
Insert button (DS), A-13
installation requirements, 2-3
Installing SunVTS, 2-3
internationalization, 2-14
interprocess communication protocols, 1-6
Intervention (CDE), 4-9
Intervention (OL), 5-5
Intervention (TTY), 6-7
IPC (interprocess communication), 1-6

K
Kerberos security, 2-8
kernel, SunVTS, 1-5
keyboard commands (TTY), 6-4

L
LANG variable, 2-14
Latest SunVTS news, 3-2
localized environment, 2-14
localized fonts, using, 2-14
locks (CDE), 4-24
locks (OL), 5-15
locks (TTY), 6-18
Log button (CDE), 4-15
log file sizes (CDE), 4-22, 5-13, 6-18
Log Period, A-15
log_files menu (TTY), 6-14
logical view
system mapping (CDE), 4-6
system mapping (OL), 5-4
system mapping (TTY), 6-6
logs (CDE), 4-15
logs (OL), 5-10
logs (TTY), 6-13
loops, 4-31

M
main windows, A-1
man pages, 2-2, 2-6
MANPATH, 2-13
Max Error option, A-19
Max Passes option, A-19
Max System Errors, A-23
Max System Log Size, 4-23, A-23
Max System Passes, A-22
Max System Time, A-23
Max Time option, A-19
Menu Bar (CDE), A-3
Message console (TTY), 6-3
Message panel (CDE), 4-16
Message panel (OL), A-7
Message panel (TTY), A-8
message syntax, 4-17
message syntax (old version), B-4
message type (CDE), 4-16
message types (OL), 5-11
message types (TTY), 6-15
Model in CDE Status panel, 4-4, A-4
modifying test options (OL), 5-6
monitoring a test session (CDE), 4-14
monitoring a test session (OL), 5-8
Monitoring a test session (TTY), 6-12
moving between options (TTY), 6-4
moving to another window (TTY), 6-4
multiple copies of a test, 4-25
multiple versions, B-2
multiprocessor systems and scaling, 4-25

N
Navigating the TTY UI, 6-4
non-english environments, 2-14
notification by email (CDE), 4-22
Index-4  SunVTS 4.4 User’s Guide • July 2001

notification by email (OL), 5-13
notification by email (TTY), 6-17
Notify dialog box (all UIs), A-15
Number of Instances option, A-19

O
old message syntax, B-4
OPEN LOOK main window, 5-2, A-6
OPEN LOOK UI, 5-1
OPEN LOOK UI support statement, 5-1
Open System Map command (CDE), 4-8
operating environment, B-2
Option File List, A-16
option file support question, B-3
Option Files (CDE), 4-11, 4-27
Option Files (OL), 5-18
Option Files (TTY), 6-22
Option Files dialog box (all UIs), A-16
Option Files field, A-16
options
device-level (CDE), 4-10
system-level (CDE), 4-10
overriding test options (CDE), 4-24
overriding test options (OL), 5-16
overriding test options (TTY), 6-19

P
packages, 2-2
Performance meter (CDE), A-4
Performance Meter (OL), A-6
physical view
  system mapping (CDE), 4-6, 5-4, 6-6
pkgadd installation, 2-3
pkginfo, 2-3
predefined test options, A-11
predetermined test options, 4-19
preparation of devices, 3-4
preserving test options (CDE), 4-24
preserving test options (OL), 5-15
preserving test options (TTY), 6-18
principal, SEAM, 2-4, 2-11
Print the log, 4-15
probable causes, 4-16
probing question, B-3
procedures overview, 3-3
processor affinity, 4-26
Processor Affinity option, A-21
protocols, interprocess communication, 1-6

Q
Quick Access buttons (CDE), A-4
Quit UI Only (DS), A-13
quitting
  TTY user interface, 6-4
  quitting SunVTS, 3-13

R
recommended corrective actions, 4-16
Record and Replay (CDE), 4-29
Record and Replay (OL), 5-21
Record and Replay (TTY), 6-25
refreshing a TTY window, 6-4
Reliable testing, 4-19
remote machine
displaying devices, 3-15
using SunVTS on a, 3-10
remote system (CDE), 4-21
removing an option file, 4-28
Removing SunVTS, 2-17
reproducing a sequence of events, 4-29
requirements for starting SunVTS, 3-2
resetting results (CDE), 4-15
Resetting test session results (TTY), 6-16
resuming a test session (CDE), 4-29
resuming a test session (OL), 5-21
resuming a test session (TTY), 6-24
return key, 6-4
reviewing results (CDE), 4-15
Run button (DS), A-14
Run On Error option, A-19
Run panel (DS), A-14
running a test session (CDE), 4-14
running a test session (OL), 5-8
running a test session (TTY), 6-12
running multi-user mode, B-2
running through a serial terminal (TTY), 6-2
Runtime Considerations, 3-1
saving a configuration (CDE), 4-27
saving a configuration (OL), 5-18
saving a configuration (TTY), 6-22
scaling a test session (CDE), 4-25
scaling a test session (OL), 5-16
scaling a test session (TTY), 6-19
Schedule dialog box (all UIs), A-17
Schedule Option menu (TTY), 6-20
Schedule options (CDE), 4-13
scripts and SunVTS, 4-17
scrolling (TTY), 6-4
SEAM security (Kerberos), 2-8
security, 1-4, 2-8
  basic, 2-8
  controlling, 2-11
  default, 2-12
  installing, 2-4
  SEAM, 2-8
  switching, 2-12
Select Devices panel (CDE), A-4
Select mode panel (CDE), A-5
Select Test panel, A-24
Select Tests button (OL), 5-5
selecting a test mode (CDE), 4-5, A-5
selecting and applying a menu choice (TTY), 6-4
selecting devices (CDE), 4-9
selecting devices (OL), 5-6
selecting devices (TTY), 6-7
Send Email menu, A-15
sequence, 4-31
Sequence Name (DS), A-13
service name, SEAM, 2-4, 2-11
set_options menu (TTY), 6-9
setting options values (TTY), 6-10
shifting to another window (TTY), 6-4
simplified configuration, 4-19
simultaneous testing, 4-25
Single Pass, A-17
Solaris Supplement CD, B-2
Solaris to SunVTS version table, B-1
spacebar, 6-4
starting a test session (CDE), 4-14
starting a test session (OL), 5-8
starting a test session (TTY), 6-12
starting the CDE interface (vtsui), 3-9
starting the Deterministic Scheduler, 4-31
starting the OL interface (vtsui.ol), 3-9
starting the TTY interface (vtstty), 3-9
Status, 4-12
Status panel (CDE), 4-4, A-4
Status panel (OL), A-6
Status panel (TTY), 6-3, 6-4, A-8
Stop button (CDE), 4-14
stopping a test session (CDE), 4-14
stopping a test session (OL), 5-9
stopping a test session (TTY), 6-13
stress level, 4-25
Stress option, A-19
Sun Management Center, B-2
SunVTS
  architecture, 1-4
  description of, 1-1
  dialog boxes, A-1
  frequently asked questions, B-1
  kernel, 1-5, 3-7
  main windows, A-1
  messages (CDE), 4-15
  OL UI, 5-1
  procedures, 3-3
  quitting, 3-13
  scripts, and, 4-17
  starting, 3-5
  TTY UI, 6-1
sunvts command, 3-5
sunvts_sec_gss file, 2-12
SUNWvts, 2-2
SUNWvtsmn, 2-2
SUNWvtsol, 2-2
SUNWvtsx, 2-2
Supplement CD, 2-4
supported revisions, B-1
Suspend, 4-4, A-4
suspending a test session (CDE), 4-29
suspending a test session (OL), 5-20
suspending a test session (TTY), 6-24
swap space considerations, 3-2
switching security, 2-12
system call, 4-23
System Concurrency, A-17
System Concurrency (CDE), 4-25
System Concurrency (OL), 5-17
System Concurrency (TTY), 6-20
System load and SunVTS, 3-1
System Map (CDE), A-5
System Map display mode (CDE), 4-6
System Map, devices in (CDE), 4-8
system mapping
W
WARNING, 4-16
Within Instance, A-21
Within Instance (CDE), 4-12
Within_Instance (TTY), 6-11

X
x86 systems, B-2